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Introduction
This guide describes how to use Siebel Call Center. It is intended for end users. 
However, managers and administrators of Siebel applications should read this book 
to understand the impact of their configuration and implementation decisions.

Although job titles and duties at your company may differ from those listed in the 
following table, the audience for this guide consists primarily of employees in these 
categories:

Call Center 
Administrators

Persons responsible for setting up and maintaining a call 
center; duties include designing and managing computer 
telephony integration, SmartScripts, and message broadcasts.

Call Center Agents and 
Customer Service 
Representatives

End users of Siebel applications who deal mainly with 
customer questions, but may also participate in marketing 
campaigns.

Marketing 
Administrators

Persons responsible for setting up and maintaining a 
marketing department; duties include designing and 
managing marketing campaigns, product marketing 
information, and product distribution lists.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers

Persons who plan, implement, and configure Siebel 
applications, possibly adding new functionality. A developer 
is typically someone from the Information Services 
department.
Version 7.5 Rev. A Siebel Call Center User Guide 9



Introduction

How This Guide Is Organized
How This Guide Is Organized
This guide provides information necessary for understanding and using Siebel Call 
Center.

Chapters of this guide focus on typical business tasks concerning individual 
customers, customer organizations, customer households, prospective customers, 
requests for service, organizing and tracking individual activities, and so on. Most 
chapters concentrate on business tasks that are accomplished using a single screen 
in Siebel Call Center, such as the Accounts screen or the Contacts screen.
10 Siebel Call Center User Guide Version 7.5 Rev. A



Introduction

Additional Resources
Additional Resources 
As you use this guide, you may find it helpful to refer to the related resources listed 
in the following paragraphs.

Additional Documentation
The following guides contain material that is related to the information in this 
guide:

■ Applications Administration Guide

■ Application Services Interface Reference

■ Fundamentals

■ Global Deployment Guide

■ Siebel Communications Server Administration Guide

■ Siebel Data Quality Administration Guide

■ Siebel eMail Response Administration Guide

■ Siebel Marketing Guide

■ Siebel Sales User Guide

■ Siebel Field Service Guide

■ Siebel SmartScript Administration Guide

■ Siebel Tools Reference

Other Resources
You may also find it helpful to view documentation updates stored on Siebel 
SupportWeb. For information about accessing documentation updates, see the 
Other Information section on the home page of the Bookshelf CD-ROM.
Version 7.5 Rev. A Siebel Call Center User Guide 11
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Revision History
Revision History
Siebel Call Center User Guide, Version 7.5 Rev. A

January 2003 Bookshelf

Additional Changes
■ Removed What’s New in This Release information from Introduction chapter.

■ Removed Appendix A. The views are referenced in specific topics.

Table 1. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision

“Call Center Communications Toolbar” on 
page 17

Revised text.

Chapter 1, “Product Overview”

“Managing the Customer Dashboard” on 
page 19

Amplified information detailing 
dashboard access to other functional 
areas.

“Displaying and Populating the Customer 
Dashboard” on page 19

Replaced general reference to the 
communications toolbar, with reference 
to Siebel CTI.

Edited text in note to reflect current 
functionality. Changed reference to 
communications server to Siebel CTI. 

Modified Customer Dashboard icon 
reference in the procedure, To Display 
the Customer Dashboard.

Modified Step 1 in the procedure, To 
Display the Customer Dashboard. 

“Siebel eMail Response and Customer 
Communications” on page 116

Added note in procedure to document 
that draft is created if you exit from 
outbound communications screen 
without canceling the email response.
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Product Overview 1
This chapter describes the typical Siebel Call Center environment, introducing the 
home page, the communications toolbar, and message broadcasting. It provides 
background information and procedures for using the customer dashboard and the 
Siebel Search Center. The chapter concludes with a discussion of how Siebel Call 
Center supports interaction with customers throughout the presales and the 
postsales interaction stages.
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Product Overview

Call Center and the Support Organization
Call Center and the Support Organization
Call Center and customer support software helps sales, telesales, and customer 
service representatives to better understand and address the needs of their 
customers. 

Siebel Call Center allows agents to handle service, support, and sales interactions 
across a broad range of communication channels such as telephone, email, fax, 
pager, wireless messaging, voice over IP, Web collaboration, and chat. These 
channels are integrated, allowing each agent to become a customer-contact 
manager, supporting a range of products and services and presenting tailored 
offerings designed to meet customers needs.

Siebel Call Center provides an array of service and telesales functionality in a single 
application. Support personnel can provide both sales and service assistance to 
customers across multiple channels within their contact centers. Siebel Call Center 
also manages customer and account profiles, product knowledge, purchase 
histories, opportunities, service requests, and service-level agreements.
14 Siebel Call Center User Guide Version 7.5 Rev. A



Product Overview

Call Center Home Page
Call Center Home Page
When an agent logs in to the Siebel Call Center application, the first screen the agent 
sees is determined by the value of the Startup Screen user preference. If this 
preference has not been set, the agent sees the home page. 

The home page is a combination of lists and forms that provide a snapshot of the 
most important information agents need to manage their day and workload. This 
information is customizable, depending on the personal preferences of each agent, 
and may include content such as My Calendar, My Activities, My Service Requests, 
My Campaigns, and My Contacts. 

Agents can change the appearance of the home page by using the controls that 
appear in the upper-right corner of each list or form. Using the controls, agents can 
show or hide the detailed records for each content area. They can also use the edit 
layout function to control what content appears on the home page, and the order in 
which the content appears. Changes remain in effect until the agent makes new 
changes.

NOTE: The home page displays only the views for which an agent has permissions, 
based on their profile.
Version 7.5 Rev. A Siebel Call Center User Guide 15



Product Overview

Call Center Home Page
Figure 1 shows the home page, including lists of service requests, activities, and a 
calendar for the current user. For more information about how to edit the layout of 
the home page, see Fundamentals.

Figure 1. Home Page 
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Product Overview

Call Center Communications Toolbar
Call Center Communications Toolbar
The communications toolbar helps agents to manage inbound and outbound 
interactions over multiple channels, including voice, email, Web text chat, and 
wireless.

Using the communications toolbar, agents can initiate outbound work items and 
accept inbound work items. In addition, agents may place work items on hold or 
transfer items to other agents using either blind transfer, consultative transfer or 
conference transfer capabilities.

Agents can also log in to or out of the work queue and set their work mode to ready 
state to accept incoming work items. The toolbar lets agents manage multiple 
simultaneous work items including combinations of emails, phone calls, and Web 
calls.

When a work item is sent to an agent, the Accept Incoming Work Item icon flashes 
with the appropriate symbol, such as a phone symbol for a phone call. The timer 
on the left side of the toolbar tracks the handling time for the currently active work 
item.

Figure 2 shows the communications toolbar. The toolbar includes icons for 
accepting a work item, initiating a work item, releasing a work item, transferring a 
call, and so on. It also includes information about how long the active work item 
has been assigned to you and how long you have been working on it. For more 
information about the communications toolbar, see Siebel Communications Server 
Administration Guide.

 

Figure 2. Communications Toolbar
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Product Overview

Call Center Message Broadcasting
Call Center Message Broadcasting
The message bar provides message broadcasting, a method of communicating 
information electronically to agents and others. It may display company 
information or critical statistics from the phone switch, such as the number of calls 
in the queue or the average call handling time. 

The broadcast messages appear as scrolling text in the broadcast bar at the bottom 
of the application. The arrows at either end of the message bar control the direction 
in which the text scrolls. Messages can be displayed in different colors to indicate 
the importance of each message. The information in the message bar can be sent to 
specific individuals, a group of people, or to all users.

To stop the message bar from scrolling, place the cursor on the message bar. To 
begin scrolling again, move the cursor away from the message bar. 

NOTE: This is the default behavior for the application. It may be changed by an 
administrator.

A counter, positioned to the right of the message bar, indicates how many broadcast 
messages there are and which message is scrolling across the screen, for example, 
2 of 4. Figure 3 shows the message bar and counter.

Figure 3. Message Bar
18 Siebel Call Center User Guide Version 7.5 Rev. A



Product Overview

Managing the Customer Dashboard
Managing the Customer Dashboard
The customer dashboard gives agents quick access to key customer data throughout 
the life cycle of a call, as well as a persistent region of the page containing the key 
data as they navigate through the application.

The dashboard displays different information depending on how Siebel Call Center 
is configured, and which application context is present when the agent populates 
or updates the dashboard. Figure 4 shows the fields that the dashboard displays 
when it is populated from the Contacts screen. These fields include Customer 
Name, Work Phone #, Account, Email Address, and so on.

The dashboard also provides access to information on assets, activities, 
entitlements, campaigns, opportunities, orders, service requests as well as 
information relating to customers and other contacts.

For information about configuring the dashboard, see Siebel Tools Reference. For 
information about configuring communication events or commands to update the 
dashboard, see Siebel Communications Server Administration Guide.

Displaying and Populating the Customer Dashboard
When open, the dashboard appears in the upper frame of the application area. The 
information displayed in the dashboard can be populated using Siebel CTI, using 
SmartScript, by clicking the Update button in the dashboard, or by clicking the Set 
Customer Dashboard button in the Search Center while a contact record is 
displayed. 

NOTE: The dashboard is read-only, and only displays customer information when it 
is open. Siebel CTI only populates the dashboard when it is open. The dashboard 
toolbar button opens the dashboard. 

Figure 4. Customer Dashboard Showing Contact Information
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Product Overview

Managing the Customer Dashboard
As a good business practice, agents should always open the customer dashboard 
before answering calls, so that the customer information is visible for reference, 
provided the organization uses Siebel CTI and it is configured to populate the 
dashboard.

The following procedures describe how to display the dashboard and how to 
manually populate the dashboard with data.

To display the customer dashboard

Use one of the following methods to display the customer dashboard:

■ In the Call Center application toolbar, click the Open Customer Dashboard 
icon.

■ In the application-level menu, choose View > Open Customer Dashboard.

To populate the dashboard with information from the current record

1 Navigate to the screen, view, and record.

2 Display the customer dashboard, as described in “To display the customer 
dashboard.” 

3 In the dashboard, click Update to display information from the selected record.

Using the Dashboard for Quick Navigation
The dashboard allows the agent to navigate to information related to data that is 
displayed in its fields. For example, when the dashboard contains contact 
information, the agent can use it to navigate to areas of the application that handle 
activities, activity plans, agreements, assets, campaigns, entitlements, 
opportunities, orders, and service requests. When the dashboard contains other 
kinds of information, the agent can navigate to areas that are relevant for the types 
of information shown.

Transferring Dashboard Information
Under some circumstances, an agent who is handling a customer call can use the 
communications toolbar to transfer both the call and dashboard information to 
another agent. In order for the dashboard information to transfer successfully, the 
agent who receives the transferred call must already have the dashboard open. 
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Product Overview

Using Search Center
Using Search Center
Siebel Search Center is a text retrieval tool that lets agents search for information 
and see the results without losing the data currently shown in the application 
window. Search Center is the central search hub for call center agents. They can 
perform broad or exact searches from anywhere within the Siebel application. 

Using the Results list in the Search Center, call center agents can attach records to 
the main record that is active in the application window. For example, a solution 
record can be attached to a service request. Agents can also preview a result record 
or make a result record the active record in the application window. Selecting 
advanced search allows searching across multiple types of information with one 
search. 

Performing a Search
Agents can perform searches to find information, (for example, to search for a 
relevant solution record), and see the results without losing data.

To perform a search

1 On the application toolbar, click the Search button to open the Search Center.

The Search button is the binocular icon located in the right side of the screen.

2 Click the Search button.

The Search Center appears in a frame in the right part of the application window.

3 From the Look In drop-down list, select the type of information you want to find.

Different fields appear depending on the selection you make.

4 Complete the fields to define your search criteria.

5 Click Search.

The records that match the search criteria appear in the Results list.
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Using Search Center
Working with Result Records
Using the Results list in the Search Center, agents can attach other records to the 
main active record in the application window, preview records or external 
documents, and search for a contact and populate the dashboard. For example, they 
can attach a solution record to a service request. 

NOTE: In order for the selected record to be associated with the main record as an 
attachment, the relationship must be established using Siebel Tools.

To attach a result record

1 In the application window, select the record to which you want to attach the 
result record.

2 Click the Search button and perform a search to find the record to attach.

The records that match your search criteria appear in the Results list.

3 In the Results list, select the record to attach.

4 Click the menu button, and then choose Attach.

The record is attached to the active record in the application window.
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Customer Interaction Life Cycle
Customer Interaction Life Cycle
Interactions between companies and potential or existing customers typically follow 
a pattern called a life cycle, composed of the following stages: 

■ Prospect stage. Your company has contact information for a prospective 
customer, but has not determined the prospect’s level of interest in your goods 
or services. Lists of prospects are often rented to companies for limited time 
periods, during which time prospect data must be kept separate from data on 
other possible customers who have voluntarily interacted with the company. 
This information is stored using the Prospect screen.

■ Candidate stage. Your company has interacted with the prospective customer and 
has determined that the prospect is interested in doing business with you. At this 
point, prospect information is typically moved to the storage area for contact 
information, and the prospect is considered to be promoted to a contact.

■ Qualified stage. Your company has determined that the contact represents a 
significant sales opportunity. At this point, an opportunity record is created.

■ Customer stage. The contact has made one or more purchases from your 
company. The status of the contact is Active.

■ Inactive stage. The contact has purchased from your company in the past, but 
has no current service agreements, and represents no current sales 
opportunities.

■ Marked for Deletion stage. The contact information has ceased to be useful, 
typically because the contact is no longer with the account or household, or 
because the account no longer exists, or because your company wants no further 
interaction with that contact, account, or household. 

Using Siebel Call Center, you can record the life cycle stage for a contact, an 
account, or a household, using the Status field in the appropriate screen. By 
indicating the life cycle stage of the record, you can make decisions on what 
resources to allocate to interactions with that contact, account, or household. The 
default Status assigned to a new contact, account, or household record is Active. 

Additional information about working with Accounts, Contacts, Households, and 
Prospects is available in the following sections:

■ For information about Accounts, see Chapter 2, “Accounts.”
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■ For information about Contacts, see Chapter 3, “Contacts.”

■ For information about Households, see Chapter 4, “Households.”

■ For information about Prospects, see Chapter 5, “Prospects.”

■ For information about working with Contacts, Prospects, and Opportunities in 
the specific context of a marketing campaign, see Chapter 12, “Campaigns and 
SmartScripts.”

■ For additional information about Opportunities, see Siebel Sales User Guide.
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This chapter describes how call center agents can use the Accounts screen to record 
information about companies and other organizations that interact with your 
company.

Account information is closely related to information about contacts and prospects, 
and is similar to information about households. Later chapters in this guide provide 
more detailed information about how to use the Contacts, Prospects, and 
Households screens. 
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Managing Business Data with the Accounts Screen 
An account can be a company representing a customer, a prospective customer, a 
partner, a supplier, or a competitor.

Call center agents can use the Accounts screen to organize and track data when 
performing the following tasks:

■ Creating accounts

■ Creating and associating activities with an account

■ Associating contacts with an account

■ Researching the following kinds of account information:

■ Service Requests

■ Contractual Agreements

■ Product Issues 

■ Activity History

■ Account Status

If your organization serves mostly businesses, the Accounts screen is a good screen 
to use when answering general inbound phone calls. If your organization serves 
mostly individual consumers, or if you are answering inbound calls related to a 
marketing campaign, the Contacts screen is a better screen to use when answering 
inbound calls.
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Business Scenario for Accounts
The Accounts screen and views often provide the central navigation point to help 
call center agents research customers and respond to inbound calls. The type of call 
determines which view is used by the agent in the application. The following 
scenarios provide examples of how the Accounts screen is used:

■ The call center agent needs to see existing account information, including the 
products owned by the account, to assist a caller with a service request or to 
follow up on a service request.

■ A caller contacts the call center in response to a sales campaign. Assuming the 
caller is unknown, the call center agent creates an new account. First, the agent 
records the account name, address, and other important information. Then, the 
agent adds a contact or enters other information about the new account. Finally, 
the agent associates the contact with the campaign that resulted in the call.

■ A call center agent wants to enter information about a prospective account. For 
example, the agent may call a prospective customer to find out if the customer 
located requested information on the company’s Web site, and whether the 
customer requires any additional information. The agent adds notes that can be 
used by a sales representative or schedules follow-up activities to help manage 
the account relationship.
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End-User Procedures for Accounts
This section includes the following end-user procedures for working with the 
Accounts screen:

■ Creating an Account on page 29

■ Adding Contacts to an Account on page 34

■ Sending Account Information to an External System on page 35
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Creating an Account
As a central object for managing customer relationships, an account record must be 
created for each prospective or customer account before other supporting 
information can be entered about the account. After an account is created, an agent 
can begin to add and track important details such as individual contacts, 
opportunities, and service requests.

To create an account

1 Navigate to the Accounts screen.

2 In the More Info form, click New, and complete the fields for the new record.

To view additional fields, click the show more button.

The following table describes some of the fields.

Field Visible by Default? Comments

Account Team Yes Employees assigned to work with 
this account. If a call center user is 
not a member of the Account 
Team, that user will not receive 
information about this account 
during Mobile Web Client 
synchronization.

Account Type Yes Indicates the relationship of the 
account to your company. Typical 
values include Customer, 
Competitor, Consultant, Partner, 
Vendor, and so on.

Address Line 1 No First line of account address. This 
value appears in some Contacts 
screen views, as well as Account 
screen views, for contacts that are 
associated with this account.
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Address Line 2 No Second line of account address. 
This value appears in some 
Contacts screen views, as well as 
Account screen views, for contacts 
that are associated with this 
account.

Assignment Area Code No Indicates account area code for 
Siebel Assignment Manager to use 
when automatically setting 
attributes such as Account Team 
memberships. Assignment 
Manager checks this value for 
matches to assignment rules.

Assignment Country Code No Indicates account country code for 
Siebel Assignment Manager to use 
when automatically setting 
attributes such as Account Team 
memberships. Assignment 
Manager checks this value for 
matches to assignment rules.

Currency No Monetary unit to be used in 
transactions with the account.

Current Volume Yes Value of the products and services 
that a customer has purchased, so 
far.

Disable Cleansing No When selected, prevents data 
quality cleansing, which verifies 
that the address is real and 
standardizes address formatting.

Domestic Ultimate DUNS No D&B D-U-N-S (Data Universal 
Numbering System) number 
belonging to the highest-level 
related member within a specific 
country.

Field Visible by Default? Comments
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DUNS # No D&B D-U-N-S number for the 
account. If the account has 
separate operations at multiple 
sites, this number applies to the 
current site.

Expertise Yes Indicates expertise level or type 
required by the account. Siebel 
Assignment Manager checks this 
value for matches to assignment 
rules when automatically setting 
attributes such as Account Team 
memberships. 

Global Ultimate DUNS No The D&B D-U-N-S number 
belonging to the worldwide 
ultimate parent company of the 
account.

Industries No Types of business engaged in by 
the account.

Location Type No Type of facility operated by the 
account at the specified site. 

Lock Assignment No When selected, prevents 
Assignment Manager from making 
changes to the Account Team.

Name Yes Name of the account.

Organization No Organization within your company 
that is assigned to work with the 
account.

Parent Yes Company of which the account is a 
subsidiary.

Parent/HQ DUNS No D&B D-U-N-S number belonging to 
the company of which the account 
is a subsidiary or to the 
headquarters site of the account.

Parent Site No Location of the company of which 
the account is a subsidiary.

Field Visible by Default? Comments
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Partner Yes When selected, indicates that the 
account selected represents an 
external enterprise that is a partner 
of your company.

PO Approved Yes When selected, indicates that the 
account may use purchase orders 
to buy goods or services from your 
company.

PO Auto-Approval Limit No Maximum value of goods or 
services the account can buy from 
your company using purchase 
orders, unless further approvals are 
obtained.

Potential Volume Yes Total estimated value of goods and 
services that a customer will buy.

Price List No List of prices to be quoted to this 
account.

Reference Yes Indicates that the account can be 
used as a reference for potential 
customers to contact.

Referenceable as of No Date the account became a 
reference.

Shipping Information No Text field for any special 
information about shipping to the 
account. 

Shipping Terms No Type of shipping charges to be 
used with this account. 

Site Yes Location of the account.

Stage Yes Phase customer has reached in the 
planning and deployment life cycle 
of the products they have 
purchased.

Field Visible by Default? Comments
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Status Yes The current stage in the customer 
interaction life cycle, as described 
in “Customer Interaction Life 
Cycle” on page 23. Defaults to 
Active for a new account record. If 
set to Candidate, only Account 
Team members will get 
information concerning this 
account during Mobile Web Client 
synchronization.

Synonyms No Text field for alternate names for 
the account. For example, an 
account record for International 
Business Machines might have 
IBM as an entry in the Synonym 
field. Helpful when querying or 
when using Siebel Data Quality.

Territories No Sales territories associated with the 
account.

Field Visible by Default? Comments
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Adding Contacts to an Account
As agents work closely with prospective or customer accounts, they need to 
accurately maintain the contacts associated with the account. The following 
procedure describes how to add one or more new contacts for an account. For 
information about adding contacts who are not associated with accounts, see “To 
create a new contact” on page 42.

To add contacts to an account

1 Navigate to the Accounts screen, and select the account in the Accounts list.

2 Click the Contacts view tab.

3 In the Contacts list, add a new record, and complete the fields.

4 Click the hyperlink in the Last Name field to navigate to the Contacts screen to 
add additional information about the contact.

For more information about the Contacts screen and available fields for 
recording contact information, see Chapter 3, “Contacts.”
34 Siebel Call Center User Guide Version 7.5 Rev. A



Accounts

Sending Account Information to an External System
Sending Account Information to an External System
If the Siebel administrator has set up real-time account integration between Siebel 
Call Center and another system in your organization, you can use the Update 
External System command to send new and modified account information from 
Siebel Call Center application to the other system.

By default, in the Accounts screen, the Update External System command triggers 
the business process Synchronize Account ASI. This business process sends 
account information to the external system, waits for a response from the external 
system, and then updates the Siebel database with the response.

The following procedure describes how to send information about an account from 
Siebel Call Center to another system. This procedure assumes that your Siebel 
administrator has completed the necessary work to enable real-time account 
integration through Application Service Interfaces (ASI). For information about ASI 
structures, see Application Services Interface Reference. For information about 
setting up ASIs, see Applications Administration Guide.

To send account and contact information to an external software system

1 Navigate to the Accounts screen, and in the Accounts list, select an account.

2 Click the Contacts view tab, and in the Contacts list, add the contacts that are 
associated with the account.

If account contacts are not yet listed, follow the instructions in “To add contacts 
to an account” on page 39 to specify account contacts.

3 In the Contacts list, click the hyperlink in the Last Name field to display the 
Contact form and an Activities list for the selected contact.

4 In the Contact form, click the menu button, and then choose Update External 
System.

You may observe a slight pause while the information is sent and the response 
from external system is received. 

5 Click the thread bar to return to the Account form.

6 In the Account form, click the menu button, and then choose Update External 
System.
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Siebel Call Center can also receive account credit information from an external 
system, using the Account Credit Profile view. For more information, see Siebel 
Sales User Guide.
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This chapter describes how call center agents can use the Contacts screen to record 
information about individuals who interact with your company.

Contact information is closely related to information about accounts and 
households, and is similar to information about prospects. Other chapters in this 
guide provide more detailed information about how to use the Accounts, Prospects, 
and Households screens. 
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Customer Calls and the Contacts Screen 
Contacts are individuals with whom a company does business or expects to do 
business in the future. The Contacts screen is one of the primary places where 
agents work when receiving inbound customer calls, particularly for businesses 
that serve individual consumers. Businesses that serve other businesses may prefer 
to work in the Accounts screen when receiving inbound customer calls. 

These tasks can be performed using the Contacts screen:

■ Verifying that a contact is an existing customer

■ Creating and maintaining contact profiles

■ Recording or viewing information about relationships between individual 
contacts

■ Recording or viewing information about relationships between contacts and 
accounts

■ Recording or viewing information about the relationship between your 
organization and an individual contact

■ Creating activities associated with a contact

■ Looking up previous activity or service history for a contact
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Business Scenario for Contacts
The Contacts screen and related views help call center agents to assist customers in 
a timely manner. For example, customers may telephone a call center to place a 
service request for a product. Agents typically follow these basic steps when a 
customer calls with a service request:

■ Verify that the database contains contact information for the caller

■ Gather profile information about the caller and the needed service

■ Provide the needed service

■ List needed or completed account activities

■ Perform any necessary follow-up tasks
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End-User Procedures for Contacts
The following sections include end-user procedures for working with the Contacts 
screen:

■ Verifying an Existing Contact on page 41

■ Creating a New Contact on page 42

■ Profiling a Contact on page 45

■ Creating a Service Request for a Contact on page 46

■ Adding an Activity for a Contact on page 49

■ Sending Contact Information to an External System on page 51
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Verifying an Existing Contact
When receiving an inbound call, the first step is typically to verify and locate the 
caller using the Contacts screen or the Search Center, if the screen is not 
automatically populated with information. To verify the caller, perform a query in 
the Last and First Name fields. If the customer is in the system, you can verify the 
additional contact information, such as account name and address. 

To find a contact using the Search Center

1 Click the Search button.

The Search Center appears in a frame at the right side of the application window.

2 In the Look In drop-down list, select Contacts.

Several search fields appear, including Last Name, First Name, Account, and 
CSN (a unique number for each customer). The administrator may configure the 
search fields differently according to the requirements or needs of your 
organization. 

3 Complete the fields to define your search.

You can use Boolean operators and keywords that are not case-sensitive. 

4 Click Search.

The records that match your search appear in the Results list. You may also set 
the dashboard with the contact’s information by clicking the Set Customer 
Dashboard button in the Search window.

5 Click the hyperlink in the Last Name field of the record in the Results list to 
display the contact record and its related activities.
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Creating a New Contact
If the caller’s contact information is not already in the system, the information can 
be added. This procedure is preferred when the contact is an individual consumer 
who is not associated with an account. For information about creating contacts for 
specific accounts, see “To add contacts to an account” on page 34.

To create a new contact

1 Navigate to the Contacts screen, and in the More Info form, click New.

2 Complete the necessary fields

Click the show more button to display additional fields.

The following table describes some of the fields.

Field Visible by Default? Comments

Account Yes Business or organization represented by the 
contact.

Account Status No The current stage in the customer 
interaction life cycle, as described in 
“Customer Interaction Life Cycle” on 
page 23. Defaults to Active for a new 
account record. 

Address Line 1 Yes Automatically populated using the value of 
Address Line 1 for the account associated 
with this contact. Separate contact 
addresses can be entered using the Contacts 
> Addresses view tab.

Address Line 2 Yes Automatically populated using the value of 
Address Line 2 for the account associated 
with this contact. Separate contact 
addresses can be entered using the Contacts 
> Addresses view tab.

Comments No Text field for any additional notes you want 
to record about the contact.

Contact Method No Method by which the contact prefers to 
receive information.
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Contact Team No Employees responsible for interacting with 
the contact. 

Disable Cleansing No When selected, prevents data quality 
cleansing, which verifies that the address is 
real and standardizes address formatting.

Employee Flag No When selected, indicates that the contact is 
an employee of your company. Includes the 
contact in picklists for fields such as 
Contact Team and Account Team.

Household No Residential group or other group of 
economically affiliated individual 
consumers to which the contact belongs. 
Typically used instead of Account if your 
company’s goods and services are being 
offered to residential groups, rather than to 
businesses. For more information about 
households, see Chapter 4, “Households.” 

Household Status No The stage in the customer interaction life 
cycle, as described in “Customer Interaction 
Life Cycle” on page 23. Defaults to Active 
for a new Household record. Automatically 
populated if Status has been set in 
Household screen. 

Lock Assignment No When selected, prevents Assignment 
Manager from making changes to the 
Contact Team.

Organization No Organization within your company that is 
assigned to work with the contact.

Registration Source No If the contact record was created by a 
person who entered his or her own contact 
information at a Web site running a Siebel 
customer application, this field identifies 
the application that was used.

Send Email Updates No When selected, indicates that the contact 
has asked to receive product information 
updates through email.

Field Visible by Default? Comments
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Site Yes Automatically populated with the value of 
the Site field for the account with which the 
contact is associated.

Status No The current stage in the customer 
interaction life cycle, as described in 
“Customer Interaction Life Cycle” on 
page 23. Defaults to Active for a new 
contact record.

     
    
  
 
 

      
    
     
  
  
 
    
   

Field Visible by Default? Comments
44 Siebel Call Center User Guide Version 7.5 Rev. A



Contacts

Profiling a Contact
Profiling a Contact
After verifying the caller’s information, agents typically complete a profile. Profiling 
a contact is the process where an agent gathers additional information about the 
contact and the contact’s specific business or service requirement. The following 
procedure describes how to enter profile information about a contact.

To add profile information 

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Profile view tab.

3 In the Profile form, complete the necessary fields.

The following table describes some of the fields.

Field Comments

Approval Authority Indicates the maximum purchase amount the 
contact can approve.

Industry Type of business engaged in by the contact. 

Send Promotions Indicates that the contact wants to receive 
promotional material. 

Send Quarterly Financials Indicates that the contact wants to receive 
quarterly financial reports on your company. 
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Creating a Service Request for a Contact
The Service Requests view associated with the Contacts screen can be used to view 
existing service requests or it can be used to add new ones. An agent can determine 
if a customer has an existing service request related to the issue by using either the 
Search Center or the Service Request view in the Contacts screen, and then 
performing a query on the information. For additional information about service 
requests, see Chapter 6, “Service Requests.”

To create a service request for a contact

1 Navigate to the Contacts screen, and in the Contacts list, locate the customer.

2 Click the Service Requests view tab.

3 In the Service Requests list, click New, and complete the fields.

The following table describes some of the fields.

Field Comments

Account Account the contact is associated with. Automatically populated if there 
is an existing Account value for the contact.

Last Name Contact’s last name. Automatically populated.

New When an asterisk appears in the New field, it indicates that the owner has 
not modified the service request record since receiving the assignment.

Owner Person in your company responsible for resolving the service request.

Site Location associated with the contact. Automatically populated if there is 
an existing Site value for the contact.

SR # A unique identifying number for the service request. Automatically 
populated.

Status Status of the service request. Defaults to Open.

Summary Overview of the service request issue.
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To add information to a contact’s service request

1 Navigate to the Contacts screen, and in the Contacts list, locate the customer.

2 Click the Service Requests view tab.

3 In the Service Requests list, locate the service request, and then drill down on 
the hyperlink in the SR # field.

The Service screen appears, showing a Service Request form and an Activities 
list.

4 In the Service Request form, complete the fields as needed.

The following table describes some of the fields.

Field Comments

Agent Closed Date and time an agent closed the service request.

Agent Committed Date and time by which the assigned agent 
promises to resolve the service request, expressed 
in terms of the agent’s local time. May be based on 
the customer’s entitlement for service.

Agent Opened Date and time an agent created the service request 
for the customer. 

Area General product or service category that the 
service request concerns.

Customer Committed Date and time by which the assigned agent 
promises to resolve the service request, expressed 
in terms of the customer’s local time. May be based 
on the customer’s entitlement for service.

Customer Opened Date and time the customer created the service 
request. Used when the customer requests service 
through a Web site, rather than by phone.

Priority Level of effort and urgency the service 
organization should devote to resolving the service 
request.
Version 7.5 Rev. A Siebel Call Center User Guide 47



Contacts

Creating a Service Request for a Contact
Severity Intensity or nature of the problem. For example, a 
service request concerning a software problem 
might indicate whether the problem is a 
typographical error in the user interface, a feature 
malfunction, a crash, or a crash with data loss.

Subarea More specific product or service category that the 
service request concerns. In conjunction with 
Area, this field is used to help assign the service 
request to an appropriate owner. The available 
values for Subarea depend on the value chosen for 
Area.

Substatus In conjunction with Status field, provides 
information about the current stage in the process 
of addressing the service request.

Field Comments
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Adding an Activity for a Contact
After completing a call, an agent often creates an activity record as a reminder to 
perform a follow-up task for the customer. The following procedure describes how 
to add an activity from the Contact screen. For more information about Activities, 
see Chapter 8, “Activities.”

To add an activity for a contact

1 Navigate to the Contacts screen, and in the Contacts list, select the contact.

2 Click the Activities view tab.

3 In the Activities list, add a record and complete the fields.

The following table describes some of the fields.

Field Comments

Display In Determines where the selected activity will be listed. Available values are 
Calendar and Activities, To Do and Activities, and Activities Only. For 
more information about Activities and the To Do list, see Chapter 8, 
“Activities.” For more information about the Calendar screen, see 
Fundamentals. 

Due Date and time by which the activity should be finished.

New When an asterisk appears in the New field, it indicates that the owner has 
not made any modifications to the activity record since receiving the 
assignment.

Owner Person responsible for completing the activity.

Start Date and time by which the activity should start.

Type Type of activity being scheduled. Defaults to Appointment.
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To add information to a contact activity

1 Navigate to the Contacts screen, and in the Contacts list select the contact, and 
then click the Activities view tab.

2 In the Activities list, select the activity record, and then drill down on the 
hyperlink in the Type field.

The Activities screen appears, showing an Activity form and an Attachments list.

3 In the Activities form, complete additional fields as needed.

The following table describes some of the fields.

Field Comments

Contacts Contacts associated with the activity. 
Automatically populated with the last name of the 
selected contact. Additional contacts can be added 
here.

Duration Estimated time required to complete the activity. If 
Start and End are specified, Duration is calculated 
automatically by subtracting End from Start. If 
Start and Duration are specified, End is calculated 
automatically by adding Duration to Start.

Employees One or more employees needed to complete the 
activity. Automatically populated with the User ID 
of the person who created the activity.

End Date and Time by which the activity should end. If 
Start and End are specified, Duration is calculated 
automatically by subtracting End from Start. If 
Start and Duration are specified, End is calculated 
automatically by adding Duration to Start.

Opportunity Sales opportunity associated with the activity.
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Sending Contact Information to an External System
If the administrator has set up real-time contact integration between Siebel Call 
Center and another system in your organization, you can use the Update External 
System command to send new and modified contact information from your Siebel 
application to the other system.

By default, in the Contacts screen, the Update External System command triggers 
the business process Synchronize Contact ASI. This business process sends contact 
information to the external system, waits for a response from the external system, 
and updates the Siebel database with the response.

For information about sending a combination of account and contact information 
to a non-Siebel system, see “To send account and contact information to an external 
software system” on page 35. 

The following procedure describes how to send information about a contact from 
Siebel Call Center to another system. This procedure assumes that the Siebel 
administrator has completed the work necessary to enable real-time contact 
integration through Application Service Interfaces (ASI). 

For information about ASI structures, see Application Services Interface Reference. 
For information about setting up ASIs, see Applications Administration Guide.

To send contact information to an external software system

1 Navigate to the Contacts screen.

2 In the Contacts list, select a contact record.

Follow the instructions in “To create a new contact” on page 42 to create a new 
record.

3 In the Contacts record, click the hyperlink in the Last Name field.

4 In the Contact form, click the menu button, and then choose Update External 
System.

You may observe a slight pause while the information is sent and the external 
system’s response is received. 
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This chapter describes how call center agents can use the Households screen to 
record information about groups of individual consumers who interact with the 
agents’ company.

Household information is closely related to information about contacts, and is 
similar to information about accounts. Other chapters in this guide provide more 
detailed information about how to use the Contacts and Accounts screens. 
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Household Contact Tracking
A household is a collection of individual consumers who are economically affiliated 
and who share common purchasing or service interests. Individuals may or may not 
be related to one another and may belong to other households. Typically, a 
household shares the same residential address. Siebel Call Center allows an 
organization to address the complexity of dynamic households by tracking all 
household information through the appropriate household contact. If contacts leave 
a household to join another, their associated information moves with them.

The Households screen displays information about customer households. You can 
use the Households screen and its related views to work with the following kinds 
of information:

■ Contacts (household members)

■ Activities

■ Attachments

■ Service Requests

■ Notes

■ Assets

■ Opportunities

■ Agreements

The Household views summarizes information that relates to all the individual 
contacts who are members of the household. For example, you might want to view 
a list of all the service requests from a particular household, regardless of which 
household member made the request.

The Household More Info view tab and the Household Contacts view tab allow 
editing, but other Household views are read-only. If you want to add activities, 
service requests, notes, attachments, assets, opportunities, and agreements, you 
must navigate to the Household Contact list and click the appropriate contact 
hyperlink to reach a view where you can enter the necessary information.
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Business Scenario for Households
Call center agents commonly use the Households screen in a business-to-consumer 
setting. Viewing household information allows for cross-selling, upselling, and sell-
through opportunities. Combined with Siebel Marketing and Analytics, the 
Households screen provides the basis for consumer segmentation and analysis.

The Households screen displays market segment information on the household as 
a whole, as well as a summary of information about the individual contacts who 
are household members. Call center agents use the Households screen to identify 
and capture demographic information about a household, and also to review assets, 
products, activities, and contact information associated with the household. This 
information helps the agent assess the customer’s data and history to better meet 
the customer’s needs.
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End-User Procedures for Households
This section describes the following end-user procedures for working with the 
Households screen:

■ Adding a Household Record on page 57

■ Adding Contacts to a Household on page 59

■ Adding Activities to Household Records on page 62

■ Storing and Viewing Information About Households on page 63

■ Sending Household Information to an External System on page 65
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Adding a Household Record
Use the following procedure to add a household record.

To add a household

1 Navigate to the Households screen.

2 In the Households list, add a record, and then complete the fields.

The following table describes some of the fields,

Fields Comments

Address Automatically populated with the address of the primary 
household contact.

Category Indicates the value of the household to your organization. 
Available values are Platinum, Gold, Silver, and Standard.

City Automatically populated with the city where the primary 
household contact resides.

Created Date and time the record was created. Automatically populated.

Created By User ID of the person who created the record.

Head of Household The main decision-maker for the household. Available values are 
all the contacts for the household.

Household # Unique indentifier for the household. Automatically populated.

Income Total income from all members of the household. 

Name A name that identifies the household. Typically this is the last 
name of one or more contacts who are members of the 
household.

Organization The organization that interacts with the household.

Revenue Revenue your organization obtains from this household.

Segment Indicates general economic class of the household, or home-
ownership status. Typical values are White Collar, Blue Collar, 
Rural, Own Residence, and Renter.

Size Total number of people in the household.
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State Automatically populated with the state where the primary 
household contact resides.

Status The current stage in the customer interaction life cycle, as 
described in “Customer Interaction Life Cycle” on page 23. 
Defaults to Active for a new household record.

Team Employees assigned to work with this household. If a call center 
user is not a member of the household team, that user will not 
receive information about this household during Mobile Web 
Client synchronization. 

Type Types of people that make up the household. Typical values 
include Family - Children, Family - No children, Family - Senior 
Citizen, and Single.

Wealth Estimated total wealth of the household.

Zip Code Automatically populated with the zip code of the primary 
household contact.

Fields Comments
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Adding Contacts to a Household
Contacts are individuals associated with a household. Agents can specify one 
person in the household as the head of household and then identify the others as 
spouse, child, or dependent parent.

To add contacts to a household

1 Navigate to the Households screen, and in the Households list, select the 
household to which the contacts will be added.

2 Click the Contacts view tab.

3 In the Contacts list, use one of the following methods to specify the contact you 
want to add:

■ To add an existing contact to the household, click Add, select the contact 
from the Add Contacts dialog box, and click OK.

■ To add a new contact to the household, click New.

4 Complete the fields for the record.

The following table describes some of the fields.

Field Comments

Alias Contact’s nickname.

Date Entered Date that the contact became a member of the household.

Date Exited Date that the contact left the household.

Employee Flag Indicates that the contact is an employee of your company.

Income Contact’s income.

Households One or more households in which the contact is a member.

Primary When selected, designates the current contact as the main decision-
maker for the household.

Relationship Indicates the role of the contact within the household.
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To specify an address for the household contact

1 Navigate to the Households screen, select the household in Households list, and 
then click the Contacts view tab.

2 In the Contacts list, select the contact and drill down on the hyperlink in the Last 
Name field.

The Contact form and an Activities list appears.

3 Click the Addresses view tab, and in the Addresses list, add a record and 
complete the fields.

4 Click the thread bar to return to the Household Contacts view, and then scroll 
down to display the Household Contacts More Info form.

5 In the More Info form, click the select button in the Address field to display the 
Contact Addresses dialog box.
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6 In the Contact Addresses dialog box, select the row and the Primary check box 
for the contact’s main address, and then click OK.

7 In the More Info form, complete additional fields.

The following table describes some of the fields.

NOTE: In the Households screen, a contact’s address is the residential or personal 
address. In the Contacts screen, the address displayed in the Contact form and 
the Contact More Info form is the address of the account associated with the 
contact. The Addresses view tab for the Contacts screen holds the list where a 
contact’s other addresses can be specified. Household addresses can only be 
selected from these individual contact addresses. 

Field Comments

Account Business or organization associated with the 
contact.

Address Contact’s address or addresses. The procedure for 
entering addresses to be displayed in this field is 
described in Step 2 on page 60.

Email Contact’s email address. 

Site Site of the account associated with the contact.
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Adding Activities to Household Records
Add activity records to household records to track appointments, meetings, email 
messages, and other tasks related to households. The following procedure describes 
how to add an activity from the Household screen. For more information about 
Activities, see Chapter 8, “Activities.” 

To add an activity for a household

1 Navigate to the Households screen, and in the Households list, select the 
household to which the activity will be added.

2 Click the Contacts view tab.

3 In the Contacts list, select the contact, and then drill down on the Last Name 
hyperlink.

The Activities view for the Contacts screen appears.

4 In the Activities list, add a new record and complete the fields.

The fields are described in “Adding an Activity for a Contact” on page 49.
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Storing and Viewing Information About Households
The following types of information can be indirectly related to a household by 
associating the information with the contact record for any member of the 
household:

■ Attachments

■ Notes

■ Opportunities

■ Service Requests

■ Agreements

■ Assets

The Household screen’s views that correspond to these types of information are 
read-only. The information must be stored and modified using Contact screen 
views.

To store additional information related to a household contact

1 Navigate to the Households screen, and in the households list select the 
household.

2 Click the Contacts view tab, and in the Contacts list select the household contact 
with whom additional information will be associated.

3 Click the Last Name hyperlink to display the Contacts screen.

4 Click the appropriate view tab for the type of information you want to add:

■ Attachments

■ Notes

■ Opportunities

■ Service Requests

■ Agreements

■ Assets

5 In the view tab list, add a new record and complete the fields.
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If the contact who is associated with Attachments, Notes, Opportunities, Service 
Requests, Agreements, or Assets leaves the household, the information stays 
accessible through the Household screen if Siebel Call Center users register the 
contact’s departure by adding an exit date to the Household Contact record. If a user 
deletes the Household Contact record for the departing contact, the information 
associated with that contact is no longer associated with the contact’s former 
household. 

To view additional information related to a household

1 Navigate to the Households screen, and in the household list, select the 
household.

2 Click the view tab for the type of information you want to view:

■ Attachments

■ Notes

■ Opportunities

■ Service Requests

■ Agreements

■ Assets

The corresponding list appears. 
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Sending Household Information to an External System
If the Siebel administrator has set up real-time household integration between 
Siebel Call Center and another system in your organization, agents can use the 
Update External System command to send new and modified household 
information from your Siebel application to the other system.

By default, in the Households screen, the Update External System command triggers 
the business process Synchronize Household ASI. This business process sends 
household information to the external system, waits for a response from the 
external system, and updates the Siebel database with the response.

The following procedure describes how to send information about a household 
from Siebel Call Center to another system. This procedure assumes that the Siebel 
administrator has completed the work necessary to enable real-time household 
integration through Application Service Interfaces (ASI). For information about ASI 
structures, see Application Services Interface Reference. For information about 
setting up ASIs, see Applications Administration Guide.

To send household and contact information to an external software system

1 Navigate to the Households screen, and in the households list, choose a 
household.

Follow the instructions in the procedure “To add a household” on page 57 to 
create a new household record.

2 Click the Contacts view tab, and choose a contact from the list.

If household contacts have not yet been added, follow the instructions in “To 
add contacts to a household” on page 59 to specify household contacts.

3 In the contact record, drill down on the hyperlink in the Last Name field.

The Contact form and an Activities list appears.

4 In the Contact form, click the menu button, and then choose Update External 
System.

You may observe a slight pause while the information is sent and the external 
system’s response is received. 
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5 Click the thread bar to return to the Household form.

6 In the Household form, click the menu button, and then choose Update External 
System.

You may observe a slight pause while the information is sent and the external 
system’s response is received. 
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This chapter describes the differences between prospects and contacts, and 
provides an overview of the general process for working with prospect data. It also 
provides cross-references to sources of further information about prospects.

For information about performing administrative tasks related to list management, 
including lists of prospects, see Siebel Marketing Guide. This chapter assumes that 
a Siebel administrator has already imported prospect data from an externally 
obtained list, and has associated prospects with campaigns.

For information about end-user procedures for managing prospects, see Chapter 12, 
“Campaigns and SmartScripts.” 

For information about working with contact data, see Chapter 3, “Contacts.”
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Prospect Qualification and Promotion
Prospects are prospective contacts, individuals who are potential customers or who 
are involved in a business activity in some other way. Prospects may be promoted 
to contacts, with associated accounts and opportunities. 

Organizations usually purchase or rent lists of prospects from third parties with the 
objective of targeting prospects with offers during marketing campaigns. Because of 
legal requirements which constrain the use of purchased or rented lists, prospect 
information is kept separate from contact information, and must be deleted after a 
specified period of time. 

A prospect can be promoted to a contact as soon as the person expresses an interest 
in doing business with your organization. Legal requirements for what constitutes 
interest vary, but the following are typical ways for a prospect to qualify as a 
contact:

■ By requesting information from your organization

■ By visiting your organization’s Web site

■ By visiting your organization’s display area at a trade show

■ By expressing interest during an outbound telemarketing phone call

Typically, a call center agent telephones a prospect during a marketing campaign, 
assesses the prospect’s level of interest in the company’s goods and services, and 
records the prospect’s response. Depending on the response and the campaign, the 
agent may modify the prospect's profile information, record the prospect's 
response, create a follow-up activity, or create an opportunity record for this 
prospect. Creating an opportunity record automatically promotes a prospect to 
contact. A prospect can also be promoted to contact without creating an 
opportunity record. For more information about working with prospects during 
campaigns, see Chapter 12, “Campaigns and SmartScripts.”
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Business Scenario for Prospects
An organization’s administrator has imported a list of prospective customers who 
will be telephoned during the company’s Special Holiday Offer marketing 
campaign. As part of setting up the campaign, the administrator assigns a specified 
portion of the list of prospects to each of the 20 call center agents. The calls must 
be made before the end of the month.

A call center agent receives a list of prospects, and begins calling them. For each 
call the agent notes whether or not the prospect is reached. For each prospect the 
agent reaches, the agent gathers information about that person’s level of interest in 
the organization’s products and services, particularly the items included in the 
Special Spring Offer.

Depending on the prospect’s level of interest, the agent takes any of the following 
actions:

■ Records that the prospect is not interested and proceed to the next call.

■ Promotes the record from the Prospect screen to the Contact screen.

■ Schedules one or more follow-up activities related to the prospect’s interest in 
the company’s goods and services, such as sending correspondence or making 
an additional call as soon as requested information is available.

■ Creates an opportunity record to reflect a situation which may produce revenue. 
Creating an opportunity record from the Prospect screen automatically promotes 
the currently selected prospect to become a contact.
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Promotion of Prospects to Contacts
If a prospect meets screening criteria, the prospect can be promoted to a contact. 
When a prospect is promoted, a contact record is created with matching field 
information, and the prospect is removed from the list of all prospects. The new 
contact record inherits any activity and campaign response information that was 
formerly associated with the prospect record. The contact Status is set to Qualified.

If Siebel Data Quality is integrated with Siebel Call Center, and if a prospect that 
matches an existing contact is promoted, a message is displayed at promotion 
asking if the existing contact record should be used, or a new contact record 
created. If the agent chooses to use the existing record, the promotion will not 
change any account information associated with that record. If the agent chooses 
to create a new record, account data may be affected as described in the remainder 
of this chapter, depending on the specific data values involved. For information 
about data quality matching, see Siebel Data Quality Administration Guide. 
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For all prospect promotions, account Status is set to Qualified. For all prospect 
promotions except those where the user receives a Data Quality message and 
chooses to use a matching existing contact record, the effect of the promotion on 
other account data depends on whether the prospect’s Account Name and Account 
Site fields match those of an existing account record. Table 2 shows the outcome for 
various data combinations.

For information about promoting prospects during marketing campaigns, see 
Chapter 12, “Campaigns and SmartScripts.” For information about promoting 
prospects from administrative screens, see Siebel Marketing Guide. 

Table 2. Effects of Prospect Promotion on Account Data

Prospect Account Value

Specified and 
Matches 
Existing 
Account

Specified but 
Does Not Match 
Existing 
Account Unspecified

Prospect Site Value

Specified and 
Matches 
Existing 
Account’s Site

The promoted 
prospect is 
associated 
with the 
existing 
account.

Not applicable A new account 
is created 
using the 
prospect’s last 
name as the 
Account Name 
value.

Specified but 
Does Not Match 
Existing 
Account’s Site

A new account 
is created for 
this account 
name and site.

Not applicable

Unspecified

A new account is created using 
the prospect’s personal address 
as the account address.

No account is 
created and no 
account is 
associated 
with the 
promoted 
prospect. 
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Service Requests 6
This chapter provides information about using Siebel Call Center to record, track, 
and address customer requests for information or assistance. It incudes procedures 
for creating a service request record, assigning the service request to an appropriate 
service representative, associating activities with the request, and closing a request 
that has been resolved.
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Tracking Customer Assistance with Service Requests
A service request (SR) is a customer request for information about, or assistance 
with, products or services bought from a company. Service request records track 
customer requests and accompanying responses, and they are the central data 
object for managing and resolving complex service issues.

Service requests allow agents to create, assign, and manage customer service issues. 
Service requests provide access to the customer’s assets, profile, open issues, 
related product issues, and service agreement information, and they can include 
short and extended descriptions of the problem, problem categories, levels of 
severity and priority, and status tracking with the opening and closing date and 
time. Each service request can also include many important details such as related 
activities, related attachments, and relevant solutions.

Use the Service Requests screen to perform the following activities:

■ View, create, and update service requests

■ Enter information about activities related to a service request

■ View information associated with a service request, including attachments, 
solutions, and decision issues

■ Log Change Requests associated with a service request

■ Conduct customer satisfaction surveys associated with a service request

■ Create and view status of service orders

■ View audit trail information for a service request

■ View graphical analysis charts of summary service request information
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Call Center Service Request Process
Call center agents or customer service representatives typically perform the tasks 
required to process a service request.

This is an example of a typical service request process.

1 Receive Incoming Call. A customer calls to report a problem with a product or 
service.

2 Receive and Open Request. The agent opens a service request, enters or verifies 
customer and product information, and records a description of the problem.

3 Verify Service Level and Enter Details. The agent then checks to see if the customer 
has a service agreement for the level of service needed to resolve the problem. 
The agent verifies that the agreement has not expired, and the person on the 
phone is an approved contact. If the customer does not have the appropriate 
level of service, the agent cancels the service request and routes the call to the 
appropriate department.

4 Assign the Request. When an agent is unable to resolve the problem over the 
phone, that agent can route the service request to other agents who have more 
expertise.
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Business Scenario for Service Requests
A customer calls to report that she is having problems installing the software that 
she purchased from the software organization. The customer service representative 
(CSR) opens a new service request, enters the customer and product information, 
and records the customer’s description of the problem. The application associates 
key information with the service request, which gives the CSR access to the 
customer’s profile. 

Next, the CSR checks to see if the customer has a service agreement entitling her to 
the level of service needed to fix this request, verifies that the entitlement has not 
expired, and the customer is an approved contact. After the entitlement is verified, 
the committed response time is automatically calculated and appears in the service 
request.

The CSR is able to resolve the customer’s problem, and provides solution details 
during the telephone conversation with the customer. The customer verifies that the 
solution is successful, and the CSR sends the customer a technical summary of the 
problem and the solution for future reference.
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Call Center Service Request Cycle
Service requests vary in difficulty, type of resolution, and impact on the 
organization. The typical service request cycle involves initiating a service request, 
resolving the customer service issue, and then tracking and analyzing the requests 
for process improvements.

Customer Requests
Depending on how an organization is structured, agents can receive a service 
request through many different channels. These channels may include:

■ Direct telephone calls, often routed to the agent through an Automated Call 
Distributor (ACD)

■ Email requests

■ Internet requests logged automatically by customers over the Internet 

■ Postings made to user groups

Initiating a Service Request
When opening a new request, certain information is typically necessary to begin 
processing the request, including:

■ Customer name

■ Company name

■ Nature of the request

■ Product or asset name

Based on the information gathered from the customer, the agent can determine how 
to proceed with the request.

Identifying the Customer
When a customer telephones a call center or service center, the agent must 
determine if the caller is an existing or new customer. To verify a customer, go to 
the Contacts or Accounts screen and perform a query on the information about the 
customer. This query may also be performed through the Search Center.
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If the customer exists in the system, the agent can review the requests that have 
already been entered for this customer. If the customer does not already exist in the 
system, the agent can add the customer.

NOTE: For customers using the Siebel Communications Server, this customer search 
can take place automatically when the call is received, presenting the agent with 
relevant contact information through an automated screen pop.

Creating a New Service Request
For new service issues, the agent enters the service request from the Service screen.

To create a service request

1 Navigate to the Service Requests screen and select All Service Requests from the 
Show drop-down list.

2 In the Service Requests list, create a new record.

3 Complete the fields and save the record.

Verification of Service Entitlements
Agents determine if a customer is entitled to service by navigating to the Service 
screen’s More Info view and clicking the Verify button.

The Pick Entitlements dialog box displays a list of entitlements. If nothing appears 
in the Entitlements list, it could mean one of two things:

■ The customer has not contracted to receive support

■ The customer has used the allotted entitlements

If there are entitlements listed in the dialog box, select an entitlement and click OK.

NOTE: The Entitlements screen and view are read-only. To enter information, use the 
Agreements screen. For more information on agreements and entitlements see 
Siebel Field Service Guide.
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Providing Service Request Details
After an agent has confirmed the customer’s entitlements and initiated a service 
request, he or she must enter the details so the service request can be processed and 
the issues resolved. 

To supply details to an open service request

1 Navigate to the Service Requests screen, and from the Show drop-down list, 
select All Service Requests.

2 In the Service Requests list, select the service request and drill down on the SR 
# hyperlink. 

NOTE: If you have already verified the customer’s entitlement, you should 
already be on the service request, and do not have to follow steps 1 through 3.

3 In the Service Requests form, complete the necessary fields, and then save the 
record.

NOTE: The Siebel application is configured to prevent users from deleting service 
requests to protect historical data.
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Assigning the Service Request
A service request is assigned to an agent after the details have been entered, and it 
has been determined that the issue cannot be resolved by the receiving agent.

There are two methods for assigning a service request:

■ Manual assignment

■ Assign with assistance

Manually Assigning Service Requests
Service requests can be assigned to other agents who have the expertise to resolve 
the particular service issue. Service requests can also be reassigned to balance the 
workload among agents.

To assign a service request manually

1 Navigate to the Service Requests screen, and from the Show drop-down list 
select All Service Requests.

2 In the Service Requests list, select the service request.

3 Click the More Info view tab, and in the Owner field, click the select button.

4 From the Pick Service Request Owner dialog box, select the person to whom the 
request will be assigned, and then click OK.

5 Save the record.

Using Assignment Manager to Assign Service Requests
The assign with assistance method requires an agent to use Assignment Manager. 
Assignment Manager automatically designates a customer service representative or 
call center agent based on skill level and availability.

To assign a service request with assistance

1 Navigate to the Service screen, and from the Show drop-down list, select All 
Service Requests.

2 In the Service Requests list, select the service request to assign.
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3 Click the More Info view tab, and in the More Info form, click the menu button 
and choose Assign.

NOTE: Assignment Manager either automatically assigns the service request to a 
representative or presents a list of potential assignees based on skills and other 
rating criteria. If the list of eligible assignees appears, select one and close the 
assignment window.

4 In the Employees dialog box, query for the agent to whom the SR will be 
assigned, and click Assign.

5 Save the record.
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Associating Activities with a Service Request
After creating the service request and supplying the product information, an agent 
can associate follow-up activities with the service request to assist the customer and 
close the request in a timely manner.

To associate activities with a service request

1 Navigate to the Service Requests screen, and from the Show drop-down list 
select All Service Requests.

2 In the Service Requests list, select the service request, and then click the 
Activities view tab.

3 In the Activities list, add a record.

4 In the record, complete the fields, and then save the record.

NOTE: Activities cannot be updated, and new activities cannot be appended to a 
closed service request.
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Closing a Service Request
After an agent has added the solution to the service request, the request can be 
closed, indicating to other agents that the problem is resolved.

An agent may resolve an open service request based on existing solutions. The 
solution is often attached to the service request for use by other agents in resolving 
similar service issues. For more information, refer to Chapter 7, “Solutions and 
Resolution Searching.”

To close a service request

1 Navigate to the Service screen, and from the Show drop-down list select My 
Service Requests.

2 In the Service Requests list, select the service request.

3 In the Status field, choose Closed from the drop-down list.

4 Save the record.

NOTE: When selecting Closed, the system automatically sets the Sub Status field to 
Resolved and includes the current date and time in the Closed field.
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This chapter describes how to locate information that may help to resolve service 
requests, the process of storing this type of information for use with future service 
requests, and how to make the information available to customers searching for 
solutions online.
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Solutions as a Service Request Research Tool
After the service request is assigned to a customer service representative (CSR), the 
assigned CSR begins to research a solution to the problem.

The Solutions screen allows agents to store, organize, associate, and search items 
in the knowledge database. The knowledge database categorizes and stores 
successful resolutions to similar problems, and provides published workarounds to 
common problems.

After successfully resolving a problem, the CSR can associate the solution with the 
service request as a reference. Associated solution can be made available to 
customers who used the call center or a self-service eService Web site to check the 
status of service issues. Associating the solution to the service request also makes 
it possible to resolve similar service requests without performing extensive 
research.
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Business Scenario for Solutions
A customer service representative researches a service request by investigating 
Related SRs, Decision Issues, and by using the Search Center to find relevant 
resolution documents such as white papers, articles, or technical documentation. 

After the CSR locates an appropriate resolution document, the representative 
previews the information, and then the CSR selects associates the document with 
the service request as an attachment. The next time a CSR encounters a similar 
service issue, the solution document is available to help with the resolution process.
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Researching and Using Solutions
The first step in finding a solution to a service request is to determine if a solution 
exists for this problem or a problem with similar attributes.

Customer service representatives can add a new solution, or view an existing 
solution to a service request using the Service Request screen’s Solutions view. 

Searching for Related Solutions Information
CSRs can search all solutions for related information using the Solutions screen. 
Records that match the criteria appear in the Solutions list and are returned in order 
of relevance to your query criteria. Click the record navigation buttons to view each 
record in the result list.

To manually search for a solution from the Solution screen

1 Navigate to the Solutions screen, and from the Show drop-down list, select All 
Solutions.

2 In the Solutions list, click Query, and then define your query criteria by 
completing the fields.

3 Click Go to run the query.

Associating a Solution with a Service Request
After a solution for a service request is located, or a new solution is created, the 
solution is associated with the service request.

To associate a solution with a service request

1 Navigate to the Service Requests screen, and from the Show drop-down list, 
select All Service Requests.

2 In the Service Requests list, query for the service request, and then click the 
Solutions view tab.

3 In the Solutions list, add a record.

4 In the Add Solutions dialog box, query and select the solution, and then click 
Add. 

5 Save the solution record.
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Using Search to Locate Service Solutions
After verifying that the service request is an active record, the customer service 
representative researches the SR using Search.

To search for a solution using the Search

1 Click the Search button.

The Search dialog box appears in a frame in the right part of the application 
window.

2 From the Look In drop-down list, select the type of information you want to find.

For example, you may select Smart Answer. Different fields appear depending on 
the selection you make.

3 Complete the fields to define your search criteria.

4 Click Search.

The records that match your search criteria appear in the Results list.

5 Select the relevant solution, and click Preview to view the information.

Adding New Solutions to the Database
The administrator, or a customer service representative with the appropriate 
responsibility can add new solutions to the database for others to use. 

To manually add a solution

1 Navigate to the Solutions screen, and from the Show drop-down list, select All 
Solutions.

2 In the Solutions list, add a record and complete the fields.

3 Save the solution.

Adding Activities to Service Requests
After the customer service representative has successfully resolved a service 
request, the CSR associates the research and work with the service request as 
activities. 
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To add a activity to a service request

1 Navigate to the Service screen, and from the Show drop-down list, select My 
Service Requests.

2 In the Service Request list, click the Activities view tab.

3 In the Activities list, add a record and complete the fields.

4 Save the activity record.

NOTE: If dedicated activity plans are set up, Activity Plans can be used instead of 
individual activities. For more information on activities, refer to Chapter 8, 
“Activities.”

Adding Attachments to an Activity 
While working with a list of activities, agents can click the Activity Type hyperlink 
which provides more detail about the activity. The activity form contains details 
about the activity. The Attachment list offers access to external references or files 
related to the activity. These files can be copied into the Siebel application.

To add an attachment to an activity

1 Navigate to the Service screen, and from the Show drop-down list, select My 
Service Requests.

2 In the Service Requests list, select the service request, and then click the 
Activities view tab.

3 In the Activities list, add a new record, and then click the hyperlink in the Type 
field.

The Activities form appears, with the Attachments view tab selected as the 
default.

4 In the Attachments list, add a new record, and then in the Attachment Name 
field, click the select button.

5 In the Add Attachment dialog box, click the Browse button.

6 In the Choose file dialog box, navigate to the file, and then click Open.

7 In the Attachments list, save the attachment.
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This chapter describes the use of activity records in Siebel Call Center, primarily for 
tracking tasks related to service requests. For information about tracking tasks that 
are related to marketing campaigns, see Chapter 12, “Campaigns and 
SmartScripts.”

Activities functionality is closely related to Calendar functionality, which is 
described in Fundamentals.
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Activities and Templates
Activities are tasks that are required or have been performed for the customer. In a 
customer service environment, activities are often associated with a service request 
and represent steps taken to resolve a customer issue. Activity templates are 
available representing predefined groups of sequential activities required to resolve 
or diagnose specific issues. These templates provide a quick method of creating 
consistent activity sequences representing best practices for addressing customer 
issues.

Activities are also used to represent tasks in nonservice situations such as 
scheduling and recording meetings, appointments, and interactions with customers 
and prospects. If one task leads to follow-up tasks, it is possible to associate follow-
up activity records with a parent activity record.

Activities can be viewed in several different locations, including the following: 

■ My To Do List in the Activities screen. This list shows all the user’s activities, 
regardless of status. Access this list by navigating to the Activities screen and 
choosing My To Do List from the Show drop-down list. 

■ My To Do’s in the Calendar screen. This list displays a subset of the data displayed 
in the My To Do List in the Activities screen, activities that have not been 
completed. For general information about using the Calendar screen, see 
Fundamentals.
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Business Scenario for Activities
A service department representative use the Activities screen to manage personal 
tasks and tasks associated with contacts, service requests, solutions, accounts, and 
opportunities.

After reviewing a to-do list in the Calendar screen, the service representative notices 
that the first scheduled activity is to follow up on a faxed service request from a 
customer account requesting a solution to a problem.

Because the service team uses activities to track the service request progress for the 
account, the service representative is able to prepare for a follow-up phone call by 
reviewing past activities associated with the customer.

The service representative notes that since the last phone call, another 
representative has sent literature which solves the company’s problem. The service 
representative prepares for the follow-up call based on this information. As team 
members accomplish their activities, they mark them as done, providing key status 
information. After speaking with the customer the service representative logs an 
activity, records the details of the conversation with the customer, and then closes 
the request.
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End-User Procedures for Activities
As agents work with activities to resolve customer service issues, consider these 
suggestions:

■ Determine if work has already been performed to resolve the request

■ Record new activities performed to help resolve the request

■ If appropriate, use an existing activity plan with a proven sequence of activities 
to help resolve the request

■ As activities are completed, set the activity’s status to Done.

The following sections include information about working with activities:

■ Researching a Service-Related Activity on page 95

■ Adding an Activity to a Customer Request on page 96

■ Assigning an Activity to a Team Member on page 98

■ Using an Activity Plan to Resolve Customer Issues on page 100

■ Associating a Follow-Up Activity with a Parent Activity on page 101

■ Sharing Activity Information on page 102
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Researching a Service-Related Activity
For existing service requests, agents can quickly research the history of related 
activities using the Service Requests screen. The Activities Detail view provides a 
comprehensive set of completed and scheduled activities for the service request.

To view existing activities for a service request

1 Navigate to the Service Requests screen, and from the Show drop-down list, 
select My Service Requests.

2 In the Service Requests list, select the service request, and then click the 
Activities view tab.

The Activities list represents every scheduled task for the selected service 
request as well as the service request history.

3 In the Activities list, select the activity, and then drill down on the hyperlink in 
the Type field. 

The Activity form and Attachments list appear. You can view additional details 
about the activity, or add additional details, such as supporting attachments 
using either the form or the list.
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Adding an Activity to a Customer Request
When working with a service request, the agent must record all research and other 
work performed to resolve the request. This comprehensive history can be helpful 
to others working with the particular service request, contact, or account. It also 
forms a valuable resolution record that may be used by others in the future to avoid 
duplication of effort.

Activities related to a service request are recorded on the Service Requests screen.

To add activities to a service request

1 Navigate to the Service Requests screen.

2 From the Show drop-down list, select My Service Requests.

3 In the Service Request list, select the service request, and then click the 
Activities view tab

4 In the Activities list, add a record, and complete the fields.

An activity number is automatically generated. The account and contact 
information are automatically entered from the information in the selected 
service request. 

The following table describes some of the fields.

Field Comments

Account Account that requested service. Automatically populated based on the 
Account value of the selected service request.

Attachments Indicates whether there are attachments associated with this activity. 
This field does not appear by default in the Service Activities view, but 
can be displayed through the use of the Columns Displayed command.

Description Brief note describing the needed or completed activity.

Display In Determines whether the activity will be displayed in the Activity 
screen, in the Activity screen and the Calendar screen, or in the Activity 
screen and the To Do applet. An activity cannot appear in both the 
Calendar and the To Do applet. Defaults to Calendar and Activities.

Due Date and time by which the activity should be completed.
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Employees One or more employees assigned to complete the activity. Defaults to 
the User ID of the activity creator. This field is not displayed by default 
in the Service Activities view, but can be displayed through the use of 
the Columns Displayed command, or by clicking the Type hyperlink to 
navigate to the Activities screen.

New Automatically selected when ownership is changed from the activity 
creator to another user. Automatically cleared when the new owner 
views activity details by clicking the hyperlink in the Type field. 

Owner User ID of the person assigned to complete the activity. Defaults to the 
User ID that created the activity.

Priority Importance of the activity.

Private When selected, the activity becomes visible only to the users listed in 
the Employees field and the Siebel administrator. This field is not 
visible by default in the Service Requests Activities view. It can be 
displayed by changing the Columns Displayed settings or by clicking 
the Type hyperlink to navigate to the Activities screen, and then 
clicking the show more button.

Start Date and time when the activity should start.

Status Current status of the activity.

Type General category of the activity. Defaults to a hyperlink with the value 
of Appointment. Clicking the hyperlink displays the Attachments view 
of the Activities screen, where the value of Type can be changed and 
additional activity characteristics can be specified.

Field Comments
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Assigning an Activity to a Team Member
When creating a new activity, it may be necessary to assign it to another team 
member who handles specific requests or types of tasks. When the activity is 
assigned it appears in the assigned user’s My Activities list.

NOTE: When the Category field for an activity is set to certain specific values, any 
existing entries are automatically cleared from the Owner and Employee fields, in 
order to let Assignment Manager select the best available resources for the activity. 
The Category and Employee fields are not visible by default in the Service Requests 
Activities view, but both are visible in the Activities screen when the show more 
button has been clicked for the Activities form or More Info form. The specific 
Category values that clear the Owner and Employee fields are Diagnostic, Field 
Engineer Activity, Other, Preventive Maintenance, and Repair Activity.

The following procedure describes how to assign an activity manually.

To assign or reassign an activity

1 Navigate to the Service screen, and from the Show drop-down list, select All 
Service Requests.

2 In the Service Requests list, select the service request associated with the activity 
you want to assign.

3 Click the Activities view tab.

4 In the Activities list, select the activity you want the representative to be 
reassigned or assigned to, or create a new one, as described in “To add activities 
to a service request” on page 96.

5 In the Type field, click the hyperlink to display the Activities Attachments view.

6 In the Activities form, click the show more button.

7 In the Employees field, click the select button.
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8 In the Employees dialog box, select the record of an employee who is already 
listed, or add another employee to the list by completing the following substeps:

a In the Employees dialog box, click New.

b In the Add Employees dialog box, select the employee you want to associate 
with the activity, and then click OK to return to the Employees dialog box.

9 Select the Primary field for the employee you want to assign the activity to, and 
then click OK. 

In the main window, both the Employees field and the Owner field display the 
new value. 

NOTE: The Owner value can also be entered or selected directly in the Owner 
field. If you use either of these methods, any previously assigned Owner is 
deleted from both the Owner and Employee fields, and the new Owner is 
automatically added to the Employee field as Primary.
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Using an Activity Plan to Resolve Customer Issues
An activity plan defines the activities needed to implement a project or goal, or to 
resolve issues that frequently occur. For example, if a service-oriented activity plan 
is associated with a service request, the plan might include standard set of activities 
required to resolve the SR.

Activity plans use activity templates that establish the list of activities to be 
completed. Activity templates, created by administrators, may have various levels 
of details pertinent to each member of a team, such as requisitioning parts and 
tools, steps involved in the service activities, or special directions or instructions. 
For information about activity plan administration, see Applications Administration 
Guide.

After an agent chooses an activity plan, the steps are in place to help the agent 
diagnose and resolve the customer’s issues, and the agent can move to the next 
customer call. Either an administrator or Assignment Manager can assign the 
activities to the appropriate users.

To add activities associated with an activity plan

1 Navigate to the Service screen, and from the Show drop-down list, select My 
Service Requests.

2 In the Service Request list, select the service request, and then click the Activity 
Plans view tab.

3 In the Activity Plans list, add a record, and in the Template field, select the 
appropriate activity template for the service request.

4 In the Planned Start field, enter the start date and time for activities related to 
the service request.

5 Save the Activity Plan.

Activities associated with the plan are automatically generated and appear in the 
Activities subview. 
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Associating a Follow-Up Activity with a Parent Activity
Any activity may be associated with a parent activity. For example, an activity such 
as a conference call might result in a number of follow-up activities. To record the 
relationship, the conference call activity would be specified as the parent activity 
for each of the follow-up activities. 

To associate a follow-up activity with a parent activity

1 Navigate to the Activities screen, and in the Activities list, select the child 
activity.

2 In the Parent Activity field, click the select button.

If necessary, click the show more button in either the Activity form or the More 
Info form to display the Parent Activity field.

3 In the Activities dialog box, query to locate and select the parent activity, and 
then click OK.
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Sharing Activity Information
An agent can grant permission to other users to view the agent’s activity records. 
These users may also have permission to create, modify, and delete the agent’s 
activity records. The following procedures describe how to grant this permission, 
and how to work with other activity records that you have permission to view or 
modify.

NOTE: A user can modify or delete a specific activity record if anyone who is listed 
in that activity’s Employee field has granted that user permission to modify and 
delete activities.

To grant permission for another user to work with your activity records

1 Navigate to the Calendar screen, and from the Show drop-down list, select 
Calendar Access List.

2 In the Calendar Access list, click New.

3 In the Add Employees dialog box, query to locate and select the employee to 
whom you want to grant access, and then click OK.

For more information about Query, see Fundamentals.

4 Select the check box in the Allow Updates field.

Selecting the check box allows the user to modify, delete, and add activity 
records for you.

If you want the user to be able to view your activity records, but not modify the 
records, make sure the Allow Updates check box is not selected.

The following procedure describes how to work with another user’s activity 
records, if that user has granted you permission to do so.
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To work with another user’s activity records

1 Navigate to the Activities screen, and from the Show drop-down list, select 
Others’ Activities.

2 In the drop-down list in the header of the Activities list, select the user whose 
activities you want to work with, and then click Go. 

If the user accessing the records has been granted permission to add and modify 
these records, the New button in the Activities list is available, and the user can 
work with these records as though they were his own. If the user has not been 
granted permission to make changes, the New button is inactive.
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This chapter describes how to handle service requests that involve returning 
products for replacement, refund, or repair.

Depending on the nature of an organization’s business, successful resolution of 
customer service issues may often require the creation of a service order or return 
merchandise authorization (RMA). Before an item can be returned, the organization 
usually requires a return authorization. The RMA authorizes the return and initiates 
the process by which the customer receives a replacement item, refund, or repair. 
Service orders (SOs) do not necessarily require returned merchandise, but do 
require the ordering of service products or service packages defined by the support 
organization.

Multiple types of customer return service orders are supported:

■ RMA advance exchange is supported when a replacement part is shipped 
immediately and the defective part is returned later

■ RMA repair and return is supported when the defective part is received and 
repaired and then shipped back to the customer

■ RMA return is supported when the defective or good part is received but no 
replacement or repair is required

The call center agents have immediate access to all order handling and bill 
information for each shipment, and can enter and track RMAs, as well as service 
orders. 
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Business Scenario for RMAs and Service Orders
A customer contacts a retail organization to return or repair an item that was 
purchased from the company.

The service representative creates a service order specifying the type of service 
transaction that is required, as well as information on pricing and requested 
shipment dates.

After receiving an RMA from the service representative, the customer may perform 
any of the following actions:

■ The customer returns a part for repair, and the part is fixed and returned to the 
customer.

■ The customer returns a part, and the service department sends the customer a 
replacement part.

■ The call center agent contacted by the customer dispatches a service 
representative to replace the part.
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Processing a Return Order
If the customer must return the item for repair or replacement to close the service 
request, the service representative must authorize the return. The RMA allows the 
customer to receive a replacement item, refund, or have their item repaired. 

To process a return order

1 Navigate to the Service Requests screen, and from the Show drop-down list, 
select My Service Requests.

2 In the Service Requests list, select the service request associated with the return, 
and then click the Orders view tab.

3 In the Orders list, add a new record and complete the fields.

The Type field indicates what actions must be performed for this service 
transaction. Examples are RMA Return, Repair Order, Sales Order.

The Status field default to Pending; change the status as necessary. The Site field 
is automatically completed when associated with an account.

4 Save the order record.
Version 7.5 Rev. A Siebel Call Center User Guide 107



RMAs and Service Orders

Generating a Service Order
Generating a Service Order
When generating a service order, each part number or individual service product is 
treated as a separate line item. 

Adding Line Items
A new record must be created for each line item.

To add a line item to an order

1 Navigate to the Service Requests screen, and from the Show drop-down list, 
select My Service Requests.

2 In the Service Requests list, select the service request to which the line item will 
be added, and then click the Orders view tab.

3 In the Orders list, click the Order # hyperlink of the order to which you wish to 
add.

The Line Items list and Totals form appear with the Service Order form.

4 In the Line Items list, add a record, complete the fields, and then save the record.

The Line #, Sequence, and Qty fields default to 1 and the Status field defaults to 
Pending. Modify the values in these fields as needed.

Approving an RMA to Complete the Order
Agents must approve an RMA before it can be processed. 

To approve an RMA

1 Navigate to the Service Requests screen, and from the Show drop-down list, 
select My Service Requests.

2 In the Service Requests list, select the service request, and then click the Orders 
view tab.

3 In the Orders list, select the order for which the RMA will be approved.

4 In the Order record, select the check box in the Approved field, and save the 
record.

If the Approved field is not visible, click the menu button, choose Columns 
Displayed, and add the Approved field.
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This chapter describes ways to record information about product quality and to 
track requests for changes to product functionality. It includes information about 
associating change requests with service requests, activities, and attachments.
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Change Management and the Quality Screen
Organizations can track change requests related to products, service requests, and 
solutions, and manage the change process using the Quality screen.

Service professionals can record change requests against a product or a specified 
component of a product, allowing the organization to assess the quality of a 
product. Using change management, product managers can prioritize problems, 
identify problem trends, correct defects during any stage of the product cycle, and 
estimate correction costs.

Change management also keep customers current about the status of defect 
corrections and schedules for replacement products.

Use the Quality screen and corresponding views to:

■ Create, manage, and maintain change request records

■ Create and view the activities associated with a change request

■ Keep customers informed about schedules for fixing and replacing defective 
products

■ View change requests associated with service requests

■ Create and view attachments associated with change requests

■ View a comprehensive change request history for a product

■ View charts to review important change request status information in a 
graphical format

■ Create solutions and associate them with product change requests
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Business Scenario for Quality and Change Requests 
Product quality information can be used by the service organization to help 
diagnose and resolve customer problems. For example, if a product has a known 
defect, this information needs to be documented in a place that can be used by 
others.

When a customer calls with a problem, the service representative can look up any 
related quality issues that may be contributing to the customer needs, often 
reducing the time spent researching and resolving the problem. If a resolution is not 
available, any work performed to resolve the issue is captured in the associated 
activities list. This change request and activity history is used to keep the customer 
informed of the request status, and the resolution.

Tracking quality issues also helps an organization discover possible problem areas. 
For example, if customers are calling with a common complaint about a product, 
the organization will know immediately that a problem exists and can implement a 
timely solution.
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Associating a Change Request with a Service Request
Associating a new change request with an existing service request that documents 
a product defect helps the organization assess the impact the defect is having on 
customers.

To associate a change request with a service request

1 Navigate to the Service screen, and from the Show drop-down list, select My 
Service Requests.

2 In the Service Requests list, select the service request, and then click the Change 
Requests view tab.

3 In the Change Requests list, click New.

4 In the Add Change Request dialog box, select the change request, and then click 
Add.

5 In the Change Request record, update the Type, Status, and Severity fields if 
necessary, and then save the record.
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Managing Changing Requests
The Quality screen can be used to consistently track and augment the important 
information associated with a change request. If a change request related to the 
issues does not exist, a new change request is created to keep the information in the 
system current. Attachments and activities views are used to provide additional 
information about a change request.

Adding a Change Request
Use the following procedure to create a new change request to associate with a 
service request.

To add a new change request

1 Navigate to the Quality screen, and from the Show drop-down list, select My 
Change Requests.

2 In the Change Request list, add a new record, and then complete the fields.

3 Save the change request.

The new change request can be associated with service requests, products, and 
solutions.

Associating Activities with a Change Request
It is important to track the activities taken to resolve a change request.Recording 
activities associated with a change request keeps service request progress 
information current.

To associate activities with a change request

1 Navigate to the Quality screen, and from the Show drop-down list, select My 
Change Requests.

2 In the Change Request list, select the change request, and click the Activities 
view tab.

3 In the Activities list, add a record and complete the necessary fields.

4 Save the activity record.
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Associating Attachments with a Change Request
When researching and resolving a change request, an agent might find external 
reference material and related documents, such as repair logs or email messages 
that they want to associate with the change request. Associating related material to 
the change request keeps the relevant information in one location.

To associate attachments with a change request

1 Navigate to the Quality screen, and from the Show drop-down list, select My 
Change Requests.

2 On the Change Request list, select the change request, and then click the 
Attachments view tab.

3 In the Attachments list, add a new record.

4 In the Attachment record, click the select button in the File field.

5 In the Choose file dialog box, locate and select the file, and then click Open.

If you want this document to be updated as changes are made to the original file, 
select the Update File check box.

6 Save the attachment record.
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This chapter describes two kinds of email functionality that call center agents can 
use: 

■ Replies to inbound eMail Response messages

■ Email messages created using the Send Email (F9) command

The procedures presented in this chapter are divided into three sections: 

■ Procedures that apply only to eMail Response replies

■ Procedures that apply only to Send Email messages

■ Procedures that apply to both eMail Response replies and Send Email messages

For information about administering eMail Response and Send Email, see Siebel 
eMail Response Administration Guide and Siebel Communications Server 
Administration Guide. 
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Siebel eMail Response and Customer Communications
Siebel eMail Response and Customer Communications
Email has become a popular channel through which customers communicate their 
needs to organizations. Siebel eMail Response prepares an agent to respond to a 
high volume of inbound email. It routes inbound emails to the most appropriate 
agent based on the same business logic available for routing other types of customer 
communications. 

Agents can view their inbound email queues at a glance and then, for each message, 
they can view related customer, account, service request, and opportunity profiles, 
as well as any attachments. Templates are available for use in the solutions database 
to compose customized replies to inbound emails. 
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Send Email Command Options
Using the Send Email command, call center agents can send email messages from 
any context within Siebel Call Center. Depending on how the Siebel administrator 
has configured the application, an agent can use context-specific email message 
templates to improve efficiency and standardize replies for types of 
communications that frequently occur. 

Siebel Call Center supports individual user choice regarding the software used for 
Send Email. The software options are:

■ Send Email window for Siebel applications

■ User’s preinstalled Microsoft Outlook email client

■ User’s preinstalled Lotus Notes email client

The choice of software is determined by the value of the Email Client user 
preference setting in Siebel Call Center. For information about setting this 
preference and using the Send Email command, see “End-User Procedures for Send 
Email” on page 129. 

For information about supported versions of Microsoft Outlook and Lotus Notes 
email client software, see the system requirements and supported platforms 
documentation for your Siebel application. Release notes and system requirements 
and supported platforms documentation for all Siebel applications can be found on 
Siebel SupportWeb at http://ebusiness.siebel.com/supportweb/. 
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Business Scenario for eMail Response
A call center agent works at a site where customer services are available in several 
languages. The agent must answer incoming phone calls, resolve existing service 
requests, and answer inbound eMail Response messages. Beginning with an open 
service request from the previous day, the agent uses the Send Email command to 
ask a coworker for information regarding a technical issue. 

By default, the organization uses the standard Siebel email client for Send Email 
messages generated within Siebel Call Center, but the agent prefers to use Lotus 
Notes and typically opens that software before logging in to Siebel Call Center. 
Because the agent’s user preferences in Siebel Call Center specify Lotus Notes as 
the default email client, the Send Email command does not display the standard 
Siebel email client window. Instead, when the agent uses the Send Email command, 
the agent must click the Lotus Notes icon in the task bar to display the Lotus email 
client window where a new message can be created. 

The agent uses the address book to select the recipient, and then chooses a message 
template. The recipient works in a division of the organization that is located in a 
different country, where a different language is used for daily business. The agent 
sending the email is fluent in both the language used at the local call center and the 
language used at the recipient’s call center. Because the agent frequently handles 
business in both languages, she has set her user preferences to give her access to 
email templates in both languages. The agent chooses an appropriate template in 
the recipient’s language, then composes and sends the message.
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End-User Procedures for eMail Response
This section includes the following end-user procedures for working with eMail 
Response: 

■ Setting Communications Preferences for eMail Response on page 120

■ Replying to an Inbound Email on page 122

■ Adding a Solution to Email on page 125

■ Creating a Service Request from an eMail Response on page 126

■ Associating Opportunities with eMail Response Replies on page 128
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Setting Communications Preferences for eMail Response
This section describes how to set user preferences specifically for eMail Response. 
Additional user preferences that affect both Send Email and eMail Response are 
discussed in “End-User Procedures for eMail Response” on page 119.

To set Outbound Communications preferences for eMail Response only

1 From the application-level menu, choose View > Site Map > User Preferences 
> Outbound Communications.

2 In the Outbound Communications form, complete the fields in the Email 
Response section of the form, and save the record.

The following table describes some of the fields.

Field Comments

Default Closing Template Specifies a communications template 
(for the email channel) to use as a 
closing for an email reply sent using 
Siebel eMail Response. The template 
content is inserted automatically into the 
message. It is placed after the last text 
you enter, but before the thread ID and 
the original message, if the original 
message is included.

Default Greeting Template Specifies a communications template 
(for the email channel) to use as a 
greeting for an email reply sent using 
Siebel eMail Response. The template 
content is inserted automatically at the 
beginning of the message.

Default Message Format Specifies the type of formatting to use 
for outbound email messages that are 
replies to inbound eMail Response 
messages. Available values are HTML 
and Plain Text. For more information 
about HTML formatting, see “Using 
HTML Controls in Call Center Outbound 
Email” on page 142.
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There is one additional user preference that affects eMail Response only, the Always 
Check Spelling Before Sending preference. For information about setting this 
preference, see “Setting Spell Check Preferences” on page 137.

Include Original Message in Reply When selected, automatically includes 
the current eMail Response message in 
the body of any reply to that message. 
Includes source, destination and subject 
information from the header of the eMail 
Response message.

Remain on Same View After Send (Cancel) When selected, continues to display the 
Incoming Message form, Incoming 
Attachments form, and Outgoing 
Message form after a reply to an eMail 
Response message is sent, but populates 
the forms with data from the next record 
in the current Communications list.

When not selected, shows the 
Communications list after a reply to an 
eMail Response message is sent.

Field Comments
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Replying to an Inbound Email
Agents can perform the following tasks when they are replying to an inbound eMail 
Response message:

■ View inbound email and associated information

■ Create a reply

■ Find and insert a solution or template

■ Attach a file 

■ Attach literature

■ Check the spelling and send the reply

■ Associate an email message with a new or existing contact, service request, or 
opportunity

The following procedure describes how to view inbound eMail Response messages 
and associated information.

To view inbound email and associated information

1 Navigate to the Communications screen, and the Show drop-down list, select My 
Communications or All Communications.

2 In the Communications list, select the email, and then click the hyperlink in the 
field for the type of information you want to view:

■ To display Contact information, click the hyperlink in the Last Name field.

■ To display Service Request information, click the hyperlink in the SR # field.

■ To display Opportunity information, click the hyperlink in the Opportunity 
field.

3 Click the More Info tab to view additional information about the email.

For example, the Message Sent field shows the time the email was sent by the 
sender, and the Message Received field shows the time the email was processed 
by the Communications Inbound Manager.
122 Siebel Call Center User Guide Version 7.5 Rev. A



Siebel eMail Response and Send eMail

Replying to an Inbound Email
The following procedure describes how to reply to an inbound eMail Response 
message.

NOTE: The following procedure is appropriate for a user who is working in any 
screen in the application. However, if the user is replying to a number of eMail 
Response messages, it is not necessary to navigate to the My Communications view 
for each message. If the user has just replied to another eMail Response message, 
the Outgoing Message form, Incoming Message form, and Incoming Attachments 
list are still displayed, but the forms are populated with data from the next email in 
the user’s My Communications queue. In this case, the user can begin typing in the 
Outgoing Message form immediately, without returning to the My Communications 
view.

To reply to an inbound eMail Response message

1 Navigate to the Communications screen, and from the Show drop-down list, 
select My Communications.

2 In the Communications list, select the email to which you want to respond, and 
then click Reply.

The Outgoing Messages form appears, the Incoming Messages form appears, 
and the Incoming Attachments list appears.

NOTE: If you navigate to the Outgoing Message form by clicking the Subject field 
hyperlink in the My Communication view, instead of by clicking the Reply 
button, then you must click Reply in the Outgoing Message form before working 
on the reply message. 

3 In the Outgoing Messages form, select the appropriate greeting from the drop-
down list.

The greeting text is inserted at the beginning of your reply.

4 In the Outgoing Messages form, select the appropriate category from the drop-
down list.
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5 If the system is set up to use SmartAnswer, the Category field will be 
automatically populated with a percentage value indicating the highest 
confidence level for applicability to the current message. Systems without 
SmartAnswer display all the available categories in the drop-down list sorted 
alphabetically and preceded by a hyphen. The choice of category will determine 
the templates and solutions that are available. In the Outgoing Messages form, 
select the appropriate body template or solution from the drop-down list, if the 
choice of category makes templates available. 

6 Enter the message text in the message composition field. 

7 In the Outgoing Messages form, select the appropriate closing from the drop-
down list.

8 Click Spell Checking, correct any errors, and then click Done.

9 Click Send to send the message.

To add more information to the message by attaching a known solution, see 
“Adding a Solution to Email” on page 125.

To associate the message with a particular service request, see “Creating a 
Service Request from an eMail Response” on page 126.

To associate the message with a particular opportunity, see “Associating 
Opportunities with eMail Response Replies” on page 128.

NOTE: If you need to exit the Outgoing Messages form before sending the reply, 
be sure to click Cancel first. If you do not click Cancel, Siebel Call Center will 
store a draft of the outbound communication even though you did not send it. 
To view drafts for unsent email, navigate to the All Communications or My 
Communications screen, select the email, and from the predefined Queries list, 
choose drafts.
124 Siebel Call Center User Guide Version 7.5 Rev. A



Siebel eMail Response and Send eMail

Adding a Solution to Email
Adding a Solution to Email
After the CSR resolves the customer’s inquiry, the CSR adds the solution to the 
email using the Search Center.

NOTE: This procedure assumes that your Siebel administrator has set up the Search 
Center to support searches that examine solutions. 

To add a solution using the Search Center

1 Follow Step 1 through Step 8 of “To reply to an inbound eMail Response 
message” on page 123. 

2 Click the Search Center button.

3 In the Look In drop-down list, select Solutions.

4 In the Search Center form, complete the necessary fields, and then click Search.

5 Select the solution, and then click Preview to inspect the solution.

6 Close the preview window and then click Attach.

The solution is attached to the body of the email reply, immediately above the 
copy of the incoming message.

7 When you are ready to send the message, click Send.

NOTE: Templates and solutions can be chosen for eMail Response replies either 
from the Outgoing Messages Form, or from the Search Center, provided that the 
Outgoing Messages Form is the active window when the Search Center is used. 
If Search Center is used, more solution and template choices may be available 
than from the Outgoing Messages form. For a given template choice, either 
method of choosing the template produces the same results. For a given solution 
choice, using the Search Center causes the solution to be attached to the eMail 
Response reply, and using the Outgoing Messages form causes the solution to be 
copied into the body of the eMail Response reply.
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Creating a Service Request from an eMail Response
If an agent decides that an inbound eMail Response message is a service request, 
the agent can use the following procedure to create a service request record that is 
automatically populated with information from the email message. When this has 
been done, additional email interactions in the same email thread are also tracked 
as being associated with the service request. 

To create a service request from an eMail Response message

1 Navigate to the Communications screen, and from the Show drop-down list, 
select My Communications.

2 In the Communications list, select the email for which you want to create a 
service request.

3 In the Pick Service Request dialog box, click New to display a Pick Service 
Request form populated with data from the email message.

4 In the Owner Group field, click the select button to display the Pick Service 
Group dialog box.

5 Select a group and click OK to return to the Pick Service Request form.

6 Click Save to return to the Pick Service Request dialog box.

7 Click OK to create the service request and return to the main window.

The following procedure describes how to associate an outbound reply with a 
service request, if no service request association has been inherited from the 
original the inbound message. 
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To associate a service request with a reply

1 Follow Step 1 through Step 8 of “To reply to an inbound eMail Response 
message” on page 123.

2 In the Outgoing Messages form, click the select button in the in the SR # field.

3 In the Pick Service Request dialog box, use one of the following methods to 
associate the reply with a service request

■ To associate the reply with an existing service request, select the service 
request you want to associate with the email message, and then click OK. 

■ To associate the reply with a new service request, click New to display a Pick 
Service Request form, optionally complete the Owner Group field, click Save, 
and then click OK.

4 When you are ready to send the message, click Send.
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Associating Opportunities with eMail Response Replies
An agent can also associate an opportunity with any reply to an eMail Response 
message. This informs sales representatives about the status of an outstanding issue 
for the account, so the sales effort can be adjusted appropriately. As with service 
requests, if an agent associates an eMail Response reply with an opportunity, 
additional email interactions in the same email thread are automatically associated 
with the same opportunity.

To associate an opportunity with a reply

1 Follow Step 1 through Step 8 of “To reply to an inbound eMail Response 
message” on page 123.

2 In the Outgoing Messages form, click the select button in the Opportunity field. 

3 In the Pick Opportunity dialog box, use one of the following methods to 
associate an opportunity with the reply.

■ To associate an existing opportunity with the reply, select the opportunity, 
and then click OK.

■ To associate a new opportunity with the reply, click New, enter a name for 
the Opportunity, and then click OK.

4 When you are ready to send the message, click Send.
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End-User Procedures for Send Email
The following procedures are included in this section:

■ Setting Outbound Communications Preferences for Send Email on page 129

■ Using the Send Email Command on page 132

Setting Outbound Communications Preferences for Send Email
This section describes how to set user preferences that only affect the Send Email 
command. Additional user preferences that affect both Send Email and eMail 
Response are discussed in “End-User Procedures for eMail Response” on page 119.

To set Outbound Communications preferences for Send Email

1 From the application-level menu, choose View > Site Map > User
Preferences > Outbound Communications.

2 In the Outbound Communications form, complete the fields in the Send Email 
section of the form, and save the record.
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3 The following table describes some of the fields.

Field Comments

Default Message Format Specifies the type of formatting to use for 
outbound email messages that are sent using the 
Send Email command. Available values are HTML 
and Plain Text. For more information about HTML 
formatting, see “Using HTML Controls in Call 
Center Outbound Email” on page 142.

Default Profile Specifies the default communications profile for a 
user to use for the Send Email and Send Fax 
commands.

The profile stores various communications 
settings and provides access to the 
communications driver that transfers information 
between the Siebel software and the email/fax 
server. For example, a profile for the Internet 
SMTP/POP3 Server driver handles outbound 
communications using the SMTP protocol. 

You have access to any profiles that are associated 
with your Siebel responsibility setting, and to any 
profiles that you create for your personal use by 
using the My Profiles view in the 
Communications screen. The ability to create 
personal communications profiles is not available 
for some responsibility settings.

The default profile information is copied to the 
From field in the Send Email and Send Fax 
windows. You can specify a different profile by 
choosing another value from the drop-down list 
for the From field.
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Default Recipient Class In some contexts, the Send Email and Send Fax 
commands let you choose email or fax recipients 
from data stored in certain fields of the current 
record. If you choose a recipient based on one of 
these current field values, the Default Recipient 
Class setting specifies the default choice for where 
recipient email or fax address information will be 
populated in the outbound message. Choices are 
To, Cc, and Bcc.

For example, you might generally want to 
populate recipients to the To field. However, 
depending on your typical activities or workflow 
and on your company’s business needs, it may be 
more appropriate to populate recipients to the Cc 
or Bcc field instead of the To field.

Email Client Determines which of the following will be used 
when the Send Email command is selected:

■ Send Email window for Siebel applications

■ Microsoft Outlook email client 

■ Lotus Notes email client 

Siebel/Lotus Form Specifies the user’s preferred outbound email 
form when Email Client is set to Lotus Notes, if 
the user prefers a default form other than the form 
specified by the Siebel administrator at the server 
level. For information about creating outbound 
forms, see Siebel Communications Server 
Administration Guide. 

Field Comments
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Using the Send Email Command
The Send Email command can be used from any screen in Siebel Call Center, and 
from many screens in other Siebel applications. In different contexts, different email 
templates can be selected from the Send Email dialog box, to standardize and 
improve efficiency for recurring types of communications.

Siebel/Outlook Form Specifies the user’s preferred outbound email 
form when Email Client is set to Microsoft 
Outlook, if the user prefers a default form other 
than the form specified by the Siebel 
administrator at the server level. For information 
about creating outbound forms, see Siebel 
Communications Server Administration Guide. 

Upon Sending Messages Generate Specifies activity generation for messages sent 
using the Send Email, Send Fax, Send Wireless 
Message, and Send Page commands. Options are:

■ No Activity. No activity record is generated by 
sending an outbound message.

■ Private activities. Sets the Internal flag to 
TRUE for an activity record generated by 
sending an outbound message, so that only 
the message sender can view the activity 
record.

■ Public activities. Sets the Internal flag to 
FALSE for an activity record generated by 
sending an outbound message, so that the 
activity record can be viewed by other users, 
in addition to the message sender.

The specific results of the Internal flag being set to 
FALSE or TRUE depend on your Siebel 
implementation. Consult your Siebel 
administrator for more information.

Field Comments
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Each call center user can set a user preference to determine the type of software that 
responds to the Send Email command. By default, the Send Email command 
displays the standard Send Email dialog box for Siebel applications. However, if 
Microsoft Outlook or Lotus Notes email client software is installed on the user’s 
workstation, a user preference can be set to display the Microsoft Outlook email 
client window or the Lotus Notes email client window, depending on which 
software is present. 

The standard functionality of the selected email client software is available while 
the email message is composed and sent. If the selected email client software is 
Microsoft Outlook or Lotus Notes, a copy of the message is placed in the user’s 
folder for sent messages. The window for the individual message closes when the 
message is sent, but the email client software remains running in the background 
until closed. 

For information about how to set the Email Client user preference, see “Setting 
Outbound Communications Preferences for Send Email” on page 129.

For information about the specific versions of Microsoft Outlook and Lotus Notes 
that are supported, see the system requirements and supported platforms 
documentation for your Siebel application. Release notes and system requirements 
and supported platforms documentation for all Siebel applications can be found on 
Siebel SupportWeb.

The following procedure describes how to send an email message using the Send 
Email window for Siebel applications.

To use the Send Email command

1 From any screen in Siebel Call Center, choose File > Send >Email from the 
application-level menu, or press the F9 key.

A Recipient/Template dialog box may appear, depending on the actions you 
take.

2 If the Recipient/Template dialog box is displayed, complete the fields, which 
may include the following, and then click OK:

■ A recipient for the message, based on a current record value.

■ A template for the message, based on the current screen, view, language, and 
locale. Click Change Language/Locale to change these settings, which may 
affect available templates.
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■ An optional literature item or other file attachment. You will also have the 
option of adding attachments from the email client window that appears 
next. 

NOTE: If you need to close the Recipient/Template dialog box before sending the 
email message, be sure to click Cancel, rather than the X-shaped Close icon in 
the upper right corner of the dialog box. If you click the Close icon instead of 
Cancel, Siebel Call Center may record an activity even though the email is never 
sent. 

3 Use one of the following methods to complete and send your email message:

■ If you are using a third-party email client, complete and send the email 
according to the provider’s instructions.

■ If you are using the Send Email window for Siebel applications, complete the 
fields.

The following table describes some of the fields.

Field Comments

From Automatically populated with the value of the Default Profile setting 
in the Outbound Communications view of the User Preferences 
screen.

To: Email addresses for one or more intended recipients. In some 
contexts, this field is automatically populated with data from the 
currently selected record. When the To button is clicked, the 
address dialog box appears, listing contacts, prospects, and 
employees. If you select a record in the address book, be sure to select 
the check box in the To field before you click OK. If the selected 
record contains a valid email address, that address appears in the 
To: field of the Send Email window.

CC: Optional. Email addresses for additional recipients. When the Cc 
button is clicked, the address dialog box is displayed. If you select a 
record in the address book, be sure to select the check box in the CC 
field before you click OK. 
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4 When you are ready to send the message, click Send. 

BCC: Optional. Email addresses for additional recipients. Addresses for 
BCC recipients are hidden from other recipients. When the Bcc 
button is clicked, the address dialog box is displayed. If you select a 
record in the address book, be sure to select the check box in the BCC 
field before you click OK.

Subject Optional. Ordinarily indicates the general topic discussed in the 
email you are sending, or the purpose of the email. In some 
contexts, this field is automatically populated with data from the 
currently selected record or the selected email template.

Body Text of the email being sent. 

Attachments Lists files that are attached to the email you are sending. 
Automatically populated based on your selections in the 
Attachments dialog box. For information about attaching a file to an 
email message, see “Adding Attachments, Literature, and URLs to 
Email” on page 139.

Field Comments
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End-User Procedures for eMail Response and Send Email
This section describes the following end-user procedures for working with both 
eMail Response and Send Email functionality:

■ Setting Shared Outbound Communications Preferences on page 136

■ Setting Spell Check Preferences on page 137

■ Setting Spell Check Preferences on page 137

Setting Shared Outbound Communications Preferences
The outbound communications preferences that are shared by eMail Response and 
Send Email are related to situations where call center agents communicate with 
customers and other contacts using multiple languages. For information about 
configuring Siebel software to use multiple languages, see Global Deployment 
Guide.

To increase efficiency for call center agents who communicate with customers in 
multiple languages, user preferences can be set to filter the list of available email 
templates based on language and locale. For example, an agent uses both English 
and French to communicate with customers. If the Language user preference is set 
to French, French email templates are listed when the user selects an email 
template. 

The Locale user preference provides a way to distinguish between templates that 
are appropriate for different countries that use the same language. For example, you 
might want templates for France and for Quebec to contain different contact 
information.

For information about how to associate individual email templates with specific 
Language and Locale settings, see Siebel Communications Server Administration 
Guide.

For information about outbound communications preferences that affect only eMail 
Response functionality, see “Setting Communications Preferences for eMail 
Response” on page 120. For information about outbound communications 
preferences that affect only Send Email functionality, see “Setting Outbound 
Communications Preferences for Send Email” on page 129.
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To set shared Outbound Communications preferences

1 From the application-level menu, choose View > Site Map > User
Preferences > Outbound Communications. 

2 In the Outbound Communications form, complete the fields in the form; some 
fields are described in the following table.

3 Click Save. 

Setting Spell Check Preferences
Siebel Spell Check can be used with the Siebel eMail Response application and the 
Send Email, Send Fax, Send Page, and Send Wireless Message features.

Siebel Spell Check dictionaries are available in several languages. All language 
dictionaries are installed regardless of the default language selected during 
installation. You can change your Spell Check default language in User Preferences.

An agent can add words to a custom dictionary. Custom user dictionaries are stored 
on the server so you can use any available workstation and still have access to the 
entire dictionary.

To change default spell check options

1 From the application-level menu, choose View > User Preferences.

The Profiles view appears.

2 In the Profiles view, select Spelling from the Show drop-down list.

Field Comments

Language Specifies the Language that will be used for filtering available email 
templates. If Language is not specified in this user preference setting, the 
application inherits the Language setting of the Siebel Object Manager. The 
user can still select the Language at run time for individual email 
messages.

Locale Specifies the Locale that will be used for filtering available email 
templates. If Locale is not specified in this user preference setting, the 
application inherits the Locale setting of the Siebel Object Manager. The 
user can still select a Locale at run time for individual email messages. 
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3 In the Spelling form, make the necessary changes, and save the form.

The follow table describes options. The changes take effect the next time an 
agent uses spell check.

Spell Check Preference Field Default Description

Ignore UPPERCASE Words Off When off, spell check questions words in 
all caps, such as SMTP or CD and asks 
whether they are correct.

Ignore Mixed Case Words Off When off, spell check questions words 
such as eMail and asks whether they are 
correct.

Ignore Internet Names Off When off, spell check questions words 
such as 
support@siebel.com and 
http://www.siebel.com/

Ignore HTML Tags On When on, spelling is not checked for any 
text enclosed in angle brackets (<>) or 
any text that follows an unmatched left 
angle bracket (<). 

Ignore Words with Digits Off When off, spell check does not questions 
words such as POP3.

Always Check Spelling 
Before Sending

Off When off, spell check does not check the 
spelling of the email body when the agent 
clicks Send. Applies to eMail Response 
reply messages. Does not apply to Send 
Email messages.

Report Capitalization 
Errors

On When on, spell check questions 
capitalization errors such as PLEase.

Default Spell Checking 
Language

Installation 
language

The current default language dictionary 
used to check spelling. The initial default 
language is the language specified during 
the Siebel system installation.

Agents may change their default language 
at any time. A new default spell checking 
language will take effect the next time an 
agent invokes spell checking.
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Adding Attachments, Literature, and URLs to Email
To assist a customer with a problem, you can add helpful literature and other 
attachments to outbound email messages that are sent using either eMail Response 
functionality or the Send Email command and the Siebel Mail Client.

NOTE: If you are using the Send Email command with the Microsoft Outlook email 
client or the Lotus Notes email client, the Recipient/Template box appears when 
you select Send Email, before the Microsoft or Lotus window is displayed. This 
dialog box allows you to specify literature items to include with the email message 
you are about to create.

You can add more than one literature item or other attachment to an outbound 
email message. All currently attached files, including literature files, are listed in the 
dialog box that appears when you click the paper clip icon. However, only the most 
recently attached file is listed in the Attachments field. 

Adding Attachments to Email
The following procedure describes how to add an attachment to an outbound email 
message. 

To add an attachment to an outbound email message

1 In the Outgoing Messages form or Send Email form, click the paper clip icon to 
the right of the Attachments field.

2 In the Attachments dialog box, select the attachment you want to add.

3 If the file is not listed in the dialog box, click New.

4 In the File Name field, click the select button.

5 In the Add Attachment dialog box, click Browse.

6 In the Choose File dialog box, select the file, and then click Open.

7 In the Add Attachment dialog box, click Add.

8 In the Attachments dialog box, click Save, and then click Close.

The attachment appears in the Attachments field.
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Adding Literature to Email
The following procedure describes how to add literature to an outbound email 
message.

To attach literature to an outbound email message

1 In the Outgoing Messages from, click the Add Literature button.

2 In the Pick Literature dialog box, select the literature you want to attach and then 
click OK.

Adding a URL to Email
You can attach a Web page URL to an outbound email message so that the email 
recipient sees the URL in the body of the email message. Depending on the software 
the recipient uses to read email, the URL may or may not be an active hyperlink to 
the designated Web page. The Web page itself is not attached. The following 
procedure describes how to add a URL to an outbound email message. 

To add a URL to an outbound email message

1 Use one of the following methods to start composing an outbound email 
message:

■ To compose an eMail Response reply, choose View > Site Map > 
Communications > My Communications from the application-level menu, 
select the email message to which you want to respond, and click Reply.

■ To compose a Send Email message, press the F9 key or choose File > Send 
> Email from the application-level menu.

2 Compose your email message as usual.

3 Click the paper clip icon that appears to the right of the Attachments field.

The Attachments dialog box appears.

4 Click New.

5 In the File Name field, click the select button to display the Add Attachment 
dialog box.
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6 In the URL field, enter the URL you want to include in your email message, and 
then click Add to return to the Attachments dialog box.

7 Click Save, and then click Close. 

The URL appears in the Attachments field. The email recipient will see the URL 
at the end of the body of your email message, after your text and any thread ID 
or original message that you include. If the applicable Default Message Format 
user preference is set to Plain Text, “http://” will be added automatically to the 
beginning of any URL that does not already include it.
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Using HTML Controls in Call Center Outbound Email
Siebel Call Center includes support for HTML formatting in email messages that are 
viewed or composed using Siebel Call Center. 

For inbound email messages that include HTML formatting, the Web browser that 
is used to run Siebel Call Center automatically determines how the HTML 
formatting will be displayed. For example, if you use a browser that supports the 
<BOLD> tag, Call Center shows bold text for all email text located between the 
<BOLD> tag and the </BOLD> tag.

For outbound email, the following Outbound Communications user preferences 
determine whether the message will be sent in plain text or using HTML formatting:

■ eMail Response Default Message Format

■ Send Email Default Message Format

If the appropriate preference is set for HTML formatting, special editing controls are 
available in the form where you compose your email message. These controls allow 
you to use supported HTML formatting, and also provide some standard editing 
features such as cut and paste.

For information about setting Outbound Communications user preferences, see 
“Setting Communications Preferences for eMail Response” on page 120 or “Setting 
Outbound Communications Preferences for Send Email” on page 129.

Using Editing Controls for Email Response Replies
The following procedure describes how to use the special editing controls that are 
available for eMail Response replies or Send Email messages when the 
corresponding Default Message Format preference is set to HTML.

To use special editing controls for outbound email with HTML formatting

1 Set the appropriate outbound user preference to use HTML formatting, as 
described in “Setting Communications Preferences for eMail Response” on 
page 120 or “Setting Outbound Communications Preferences for Send Email” on 
page 129.
142 Siebel Call Center User Guide Version 7.5 Rev. A



Siebel eMail Response and Send eMail

Using HTML Controls in Call Center Outbound Email
2 Use one of the following methods to start composing an outbound email 
message:

■ To compose an eMail Response reply, choose View > Site Map > 
Communications > My Communications from the application-level menu, 
select the email message to which you want to respond, and click Reply.

■ To compose a Send Email message, press the F9 key or choose File > Send 
> Email from the application-level menu.

3 In the Outgoing Message form or Send Email form that appears, click in the text 
composition area located below the Body field. 

The special editing controls appear at the bottom of the field.

4 Compose your message using the special editing controls as needed. 

For detailed information on using the editing controls, see Fundamentals.
Version 7.5 Rev. A Siebel Call Center User Guide 143



Siebel eMail Response and Send eMail

Using HTML Controls in Call Center Outbound Email
144 Siebel Call Center User Guide Version 7.5 Rev. A



Campaigns and SmartScripts 12
This chapter provides background information and procedures for using Siebel Call 
Center in marketing campaigns. It includes information about making outbound 
calls, accepting inbound calls, using call guides and SmartScripts, recording sales 
opportunities and other responses, promoting prospects to contacts, and evaluating 
campaign effectiveness.
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Campaigns Overview
Campaigns are focused efforts to create opportunities that eventually result in sales. 
Siebel Call Center helps you implement planned campaigns by providing the 
following functionality:

■ Stores information about the contacts and prospects targeted by the campaign

■ During campaign calls, shows information about special offers or other sales 
inducements to call center agents or telesales representatives, so they can 
provide the information to potential customers consistently and professionally

■ Stores information about the outcomes of campaign calls

■ Transfers campaign-generated information about sales opportunities to sales 
representatives 

Campaigns can be conducted by making outbound calls or by receiving inbound 
calls. Inbound calls can come in response to advertisements, direct mailings, or 
other communication methods. For information about planning campaigns, see 
Siebel Marketing Guide. 

Campaigns work in conjunction with customer telephony integration to 
automatically call the customer on the list when executing an outbound campaign 
or to pop-up the appropriate campaign and customer information when taking 
inbound calls for a campaign.

During a campaign call, an agent typically performs the following tasks:

■ Verifies existing information about the current contact or prospect

■ Gathers additional information about the current contact or prospect

■ Communicates current offers to the contact or prospect

■ Records whether or not the contact or prospect represents a sales opportunity

The following sections of this chapter provide detailed information about how to 
accomplish these tasks. For more information about contacts, see Chapter 3, 
“Contacts.” For more information about prospects, see Chapter 5, “Prospects.”
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Business Scenario for Campaigns
As part of an effort to increase visibility and generate more revenue from July 
through September, a software company is conducting a campaign in the Western 
region to gather information from potential customers who have accessed the 
company’s Web site. The goal of the campaign is to make sure potential customers 
can find the information they are looking for on the Web site.

The campaign begins with a list of individuals who clicked the More Information 
button on the company’s Web site. The call center agents begin calling these 
potential customers, and following each call, they update the customer information, 
note the result of the call, and generate business leads for the sales department. 
Information is derived from the answers given by each potential customer to a 
series of questions.

Based on the answers given, the agent marks the potential customer’s record as 
information only, no interest, or promote to opportunity. If there is an opportunity, 
the agent creates an opportunity record and begins profiling the opportunity by 
asking a series of questions about the customer's needs.
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Understanding Campaigns
This section provides overview information that you will need to understand the 
instructions provided in the “Making Outbound Campaign Calls” section. This 
section assumes that you are already familiar with the information in Chapter 3, 
“Contacts,” and Chapter 5, “Prospects.”

Call Guides and SmartScripts
During campaign calls, whether inbound or outbound, agents often use call guides 
or SmartScripts to make sure that the information given to the contact or prospect 
is correct, complete, and professionally delivered. 

A call guide is prepared text that the agent can read or reference during the call. A 
SmartScript is a more flexible method of directing communication during a call—
the agent asks a series of specific questions, and the SmartScript suggests different 
follow-up questions and statements depending on how the contact or prospect 
responds to each question. 

Call guides and SmartScripts are prepared as part of campaign planning. For 
information about planning campaigns and creating call guides, see Siebel 
Marketing Guide. For information about creating SmartScripts, see Siebel 
SmartScript Administration Guide.

For information about using a call guide during a campaign call, see “To use a call 
guide during a campaign call” on page 153. For information about using a 
SmartScript during a campaign call, see “To use a SmartScript during a campaign 
call” on page 155.
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Campaign Response Types
When a campaign is planned, the campaign is assigned a response type. The 
response type affects the availability of certain buttons in Campaign views, and it 
is used to indicate the level of detail that agents are expected to gather for certain 
kinds of campaign responses. Table 3 lists the purposes of each response type, and 
the buttons that are available for that type in the Campaign Overview view and the 
Campaign Contacts/Prospects view.

Attachments, orders, and products can be associated with either response or 
opportunity records. Campaigns of either response type can be set to create a 
response record, automatically, when an agent creates an opportunity record. 
Marketing managers and campaign managers use these response records to 
evaluate the performance of the campaign. The following paragraphs provide more 
detail about how agents typically interact with each response type.

Table 3. Response Type Purposes and Button Availability

Response Type Purposes Available Buttons

Opportunity ■ Record detailed information about 
campaign responses that represent sales 
opportunities. 

■ Record minimal information about 
campaign responses that do not represent 
sales opportunities. This can be done in 
the Campaign Overview view or the 
Campaign Contacts/Prospects view, 
without switching to the Responses 
screen.

■ Create 
Opportunity 

■ View Responses

Response ■ Record detailed information about all 
campaign responses, whether or not they 
represent sales opportunities.

■ Especially appropriate for campaigns that 
are not expected to result in immediate 
sales opportunities, such as campaigns to 
encourage attendance at an upcoming 
event, or campaigns that survey existing 
customers on questions not directly 
leading to sales.

■ Create 
Opportunity

■ Create Response

■ View Responses
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Response Campaigns
When a Response campaign is in progress, the agent normally works in the 
Overview view of the Campaigns screen. When a contact or prospect is successfully 
reached, the agent clicks Create Response to display the Response screen, where 
detailed information about the level of interest of the contact or prospect can be 
recorded. After recording the response, the agent clicks the thread bar to return to 
the Campaigns Overview.

Opportunity Campaigns
When an Opportunity campaign is in progress, the agent also normally works in the 
Overview view of the Campaigns screen. When a contact or prospect is successfully 
reached, the agent determines the level of interest of the contact or prospect, then 
uses one of the following options to record the outcome:

■ To record a sales opportunity, the agent clicks Create Opportunity, to display the 
Opportunity screen, where detailed information can be recorded. After recording 
the opportunity, the agent clicks the thread bar to return to the Campaigns 
Overview view. Clicking Create Opportunity automatically selects the Done 
check box in the Campaigns Overview view.

■ To record anything except a sales opportunity, the agent continues to work in the 
Campaign Overview view, choosing appropriate settings for the Status and Call 
Outcome field. When finished, the agent selects the Done check box and 
proceeds to the next Contact or Prospect record. 

Provided that the campaign has a Primary Offer, either manual or automatic 
selection of the Done check box automatically creates a Response record. When this 
occurs, the value of the Outcome field in the Campaign Overview is automatically 
mapped to an equivalent value in the Response Type field in the Response record. 
If there is no Primary Offer for the campaign, no Response record is created.

The following sections describe typical campaign tasks performed by call center 
agents:
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Making Outbound Campaign Calls
The following procedure describes how to make an outbound call to a campaign 
contact or prospect. To communicate offers using call guides or SmartScripts, see 
“Making Offers Using Call Guides” on page 153, and “Making Offers Using 
SmartScripts” on page 154. To record responses for both Response and Opportunity 
campaign types, see “Recording Campaign Opportunities” on page 156.

NOTE: The following procedure uses the Campaign Overview view during outbound 
campaign calls. If you prefer, you can use the Campaign Contacts/Prospects view, 
instead.

To make an outbound campaign call

1 Navigate to the Campaigns > My Campaigns view.

The Campaigns list displays active campaigns with which you are associated, 
based on the Start and End Dates of the campaigns.

2 In the Campaign list, select the campaign for which you want to make outbound 
calls.

3 Click the Overview view tab.

4 Select the record of the campaign contact or prospect to call.

5 If you are using the Siebel communications toolbar, click the Make Call icon on 
the toolbar to place the call. Otherwise, use standard techniques to place the call 
manually.

6 Depending on whether your campaign uses a call guide or a SmartScript, refer 
to the appropriate procedure for communicating campaign offers to the current 
contact or prospect:

■ If your campaign uses a call guide, see “To use a call guide during a campaign 
call” on page 153.

■ If your campaign uses a SmartScript, see “To use a SmartScript during a 
campaign call” on page 155.
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Answering Inbound Campaign Calls
The following procedure describes how to answer an inbound campaign call. 

To answer an inbound campaign call

1 Identify the caller and the campaign to which the caller is responding.

2 Use Siebel Search to determine whether the caller is already listed in the 
database, as either a contact or a prospect, and then follow one of the following 
procedures:

a If the caller is already listed in the system:

❏ Click the Last Name hyperlink in the Search Center result to navigate to 
the Contact or Prospects screen, and then click the Campaigns view tab. 

❏ Use the Campaigns list to determine whether the caller is already 
associated with the campaign that prompted the call. 

❏ If the association does not already exist, click New and specify the 
campaign name to create the association. 

b If the caller is not listed in the system:

❏ Navigate to the Contacts screen, create a record for the caller in the 
Contacts list, and then click the Campaigns view tab. 

❏ In the Campaigns list, click New and specify the campaign name to create 
the association.

3 In the Contacts Campaigns list, click the Campaign hyperlink for the relevant 
campaign to navigate to the Campaigns screen.

4 Click the Overview view tab, and then select the record for the caller from the 
Overview list. 

5 Depending on whether your campaign uses a call guide or a SmartScript, refer 
to the appropriate procedure for communicating campaign offers to the current 
contact or prospect:

■ If your campaign uses a call guide, see “To use a call guide during a campaign 
call” on page 153.

■ If your campaign uses a SmartScript, see “To use a SmartScript during a 
campaign call” on page 155.
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Making Offers Using Call Guides
The following procedure describes how to use a call guide to communicate 
campaign offers during a campaign call.

To use a call guide during a campaign call

1 Navigate to the Campaigns screen, and in the Overview view, select the 
appropriate campaign and contact or prospect.

For more information, see “Making Outbound Campaign Calls” on page 151 or 
“Answering Inbound Campaign Calls” on page 152.

2 Scroll down until the Call Guide form is visible.

3 Use the text in the Call Guide form to help you present campaign offer 
information and ask qualifying questions.

4 Depending on the type of campaign, refer to the appropriate procedure for 
recording the caller’s response to the campaign:

■ If the campaign Type is Opportunity, see “To create a campaign opportunity 
record” on page 156 to record a campaign response that represents a sales 
opportunity. 

■ See “To record a brief campaign response” on page 157 for information about 
how to record a campaign response that does not represent a sales 
opportunity.

■ If the campaign Type is Response, see “To create a campaign opportunity 
record” on page 156 for information about how to record a campaign 
response that represents a sales opportunity. 

■ See “To create a detailed campaign response record” on page 160 for 
information about how to record all other campaign responses.
Version 7.5 Rev. A Siebel Call Center User Guide 153



Campaigns and SmartScripts

Making Offers Using SmartScripts
Making Offers Using SmartScripts
This section describes how to use a SmartScript to communicate campaign offers 
during a campaign call. When a SmartScript is launched, the SmartScripts Explorer 
view appears. To use this feature, the agent asks the customer a series of questions 
that appear on the agent’s screen. After recording each answer, the agent clicks the 
Next button and proceeds to the next question. The most current question is 
highlighted in the left pane of the Explorer window.

Markings in the Explorer window indicate the following:

■ The red asterisk indicates a required field.

■ The question mark means that the question is optional.

NOTE: If you are interrupted while using a SmartScript, you can save the script by 
clicking Finish Later. You can resume the script at a later time by navigating to the 
SmartScripts > My Saved Sessions view, selecting the session, and clicking 
Resume. If you change to another screen or view while running a SmartScript, the 
application remembers the last active question when you return to the script. 

The following procedure initiates the use of a SmartScript from the Campaign 
Overview view. SmartScripts can also be started from the Campaign Contacts/
Prospects view or the SmartScripts screen.

For information about creating SmartScripts, see Siebel SmartScript Administration 
Guide.

NOTE: The Language field for the SmartScript determines which language the script 
runs on. If no language is selected then the system defaults to the application 
default language.
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To use a SmartScript during a campaign call

1 Navigate to the Overview view of the Campaigns screen, and select the 
appropriate campaign and contact or prospect.

For more information, see “To make an outbound campaign call” on page 151 or 
“To answer an inbound campaign call” on page 152.

2 In the Overview list, click Script to access the SmartScript associated with the 
campaign.

3 In the SmartScript Explorer view, read the bold text aloud, complete each field 
based on the contact’s or prospect’s response, and then click Next. 

The information you enter is stored in locations that depend on how your 
SmartScript is configured. Consult your Siebel administrator for information 
about whether you need to record additional response information, or if the use 
of the SmartScript is adequate.

4 When you are finished asking questions, click Finish to return to the Campaign 
Overview view.

5 Depending on the type of campaign you are participating in, refer to the 
appropriate procedure for recording the caller’s response to the campaign:

■ If the campaign Type is Opportunity, see “To create a campaign opportunity 
record” on page 156 for information about how to record a campaign 
response that represents a sales opportunity. 

■ See “To record a brief campaign response” on page 157 for information about 
how to record a campaign response that does not represent a sales 
opportunity.

■ If the campaign Type is Response, see “To create a campaign opportunity 
record” on page 156 for information about how to record a campaign 
response that represents a sales opportunity. 

■ See “To create a detailed campaign response record” on page 160 for 
information about how to record all other campaign responses.
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Recording Campaign Opportunities 
The following procedure describes how to record a customer interaction that 
represents a sales opportunity. Only one opportunity record can be created for each 
campaign contact or prospect. This procedure applies to both Opportunity and 
Response campaign types.

NOTE: When you create an opportunity while a record of type Prospect is selected, 
the type is automatically changed to Contact, and other data changes may take 
place. When you create an opportunity for a prospect that is associated with a D&B 
D-U-N-S number, all other prospects associated with this D-U-N-S number are also 
promoted to contacts, and are associated with the new account, and are added to 
the opportunity. For information about the effects on data of promoting a prospect, 
see “Prospect Qualification and Promotion” on page 68. For information about 
promoting a prospect to a contact when there is no current sales opportunity, see 
“Promoting Campaign Prospects to Contacts” on page 163.

For more information about working with the Opportunity screen, see Siebel Sales 
User Guide.

To create a campaign opportunity record

1 Navigate to the Overview view of the Campaigns screen, and select the 
appropriate campaign, and the contact or prospect.

For more information, see “To make an outbound campaign call” on page 151 or 
“To answer an inbound campaign call” on page 152.

2 Use the call guide or a SmartScript to verify that the contact or prospect 
represents a sales opportunity.

For more information, see “To use a call guide during a campaign call” on 
page 153 or “To use a SmartScript during a campaign call” on page 155. 

3 In the Overview list, click Create Opportunity.

This command creates a campaign response record with Response Type set to 
Created Opportunity, and displays the Campaign Leads view for the Opportunity 
screen.
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4 Complete the fields in the Opportunity form.

NOTE: One way to assign an opportunity to a sales representative is to add the 
representative to the Sales Team multi-value group in the Opportunity form, and 
select the Primary check box for that representative. Alternatively, your 
implementation may be set up to assign a sales representative to an opportunity 
automatically, using Assignment Manager. Consult your Siebel administrator for 
more information. 

5 Scroll down to the Profile form and complete the fields.

The profile stores information about the sales opportunity, rather than the 
contacts associated with the opportunity. You can complete the profile fields 
manually, or click Script to complete the fields by using SmartScript. 

6 (Optional.) In the Activities list, add activities related to the opportunity.

7 Return to the Campaign Overview view and proceed to your next call.

Recording Non-Opportunity Campaign Responses 
The following procedures describe how to record campaign responses that do not 
represent sales opportunities. The first procedure applies to campaigns of type 
Opportunity, and in cases where a campaign of type Response does not require a 
detailed response. The second procedure applies to campaigns where a detailed 
response is required.

To record a brief campaign response

1 Navigate to the Overview view of the Campaigns screen, and select the 
appropriate campaign and contact or prospect, as described in “To make an 
outbound campaign call” on page 151 or “To answer an inbound campaign call” 
on page 152.

2 Use the call guide or a SmartScript to verify that the current contact or prospect 
does not represent a sales opportunity, as described in “To use a call guide 
during a campaign call” on page 153 or “To use a SmartScript during a campaign 
call” on page 155.
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3 In the Overview list, complete the Call Status and Outcome fields for the current 
contact or prospect, as well as any additional fields required for your campaign; 
some fields are described in Table 4, following this procedure. 

4 When you are finished, select the Done check box, and proceed to your next call.

Table 4. Some Fields in the Campaign Overview List

Field Comments

Call Status Status of call attempts. Typical values include Busy, Call Back 
Later, Call Completed, In Progress, Left Message, No Answer, 
and Not Completed. By default, this field is for informational 
purposes only.

Contact Last Name Last name of a contact to speak with during the campaign. If 
this field is populated, the Prospect Last Name field is blank. 
Campaign administrators associate contacts with campaigns. 

Date/Time Date and time when the Done check box is selected. The check 
box can be selected manually or it can be selected automatically 
by creating a response or an opportunity.

Done When selected, indicates that the campaign call has been 
completed for the selected contact or prospect, and sets the 
record to be read-only. Automatically selected when you create 
a response or an opportunity. For a campaign that has a Primary 
Offer, manually selecting Done automatically creates a response 
record, and the Campaign Overview Outcome field is mapped 
to the equivalent Response Type field in the response record.

First Name First name of a contact or prospect to speak with during the 
campaign. Automatically populated when campaign 
administrators associate a contact or prospect last name with 
the campaign.

Job Title Occupation of the contact or prospect. Automatically populated 
from contact or prospect data. 

Organization Owner Organization within your company that is responsible for 
interacting with the contact or prospect. If your administrator 
has selected Enable Contact Editing in the Campaign 
Administration > Execution Options view, this field is 
automatically populated with the organization of the person 
who created the selected contact or prospect record.
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The following procedure describes how to record a detailed response that does not 
represent a sales opportunity. This would ordinarily be done for a Response 
campaign. For a campaign that tracks every interaction with a potential customer, 
there may be several responses for an individual contact or prospect, including brief 
responses such as requests to call another time. 

Outcome Result of the campaign call. Typical values include Created 
Opportunity, Created Response, Gave Referral, No Interest, 
Requested Call Back, Requested More Info, Respondent 
Interested, and Unable To Reach Contact. Automatically 
populated if you click Create Opportunity or Create Response, 
otherwise you must select a value. For a campaign that has a 
Primary Offer, when the Done check box is selected, the value 
of the Outcome field is mapped to the equivalent Response Type 
field of an automatically created response record.

Position Owner Indicates the position within your company that is responsible 
for interacting with the contact or prospect. If your 
administrator has selected Enable Contact Editing in the 
Campaign Administration > Execution Options view, this field 
is automatically populated with the position of the person who 
created the selected contact or prospect record.

Prospect Last Name Last name of a prospect to speak with during the campaign. If 
this field is populated, the Contact Last Name field is blank. 
Campaign administrators associate prospects with campaigns. 

Type Indicates whether the person to be spoken with is classified as 
a contact or a prospect. Automatically populated based on 
contact or prospect data. Changes from Prospect to Contact if 
you click Promote.

Table 4. Some Fields in the Campaign Overview List

Field Comments
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To create a detailed campaign response record

1 Navigate to the Overview view of the Campaigns screen, and select the 
appropriate campaign and contact or prospect, as described in “To make an 
outbound campaign call” on page 151 or “To answer an inbound campaign call” 
on page 152.

2 Use the call guide or a SmartScript to verify that the current contact or prospect 
does not represent a sales opportunity, as described in “To use a call guide 
during a campaign call” on page 153 or “To use a SmartScript during a campaign 
call” on page 155.

3 In the Overview list, click Create Response to display the Responses list, a More 
Info form, and the Response Details form. 

4 Complete the appropriate fields in the More Info form; some fields are described 
in Table 5 on page 161.
160 Siebel Call Center User Guide Version 7.5 Rev. A



Campaigns and SmartScripts

Recording Campaign Opportunities
5 To enter additional information about the response, complete the appropriate 
fields in the Response Details form; some fields are described in Table 6 on 
page 161. 

Table 5. Some Fields in the Campaign Responses More Info Form

Field Comments

Lead Partner Partner organization that provided the lead to the contact.

Method How the contact was reached.

Offer Code Unique number assigned to each offer. Automatically populated.

Outcome Summarizes the results of the campaign for the current contact or 
prospect. Typical values include Created Order, Existing Customer, 
Existing Opportunity, Invalid Phone #, No Project Now, and so on.

Response Type Summarizes the type of response received from the current contact or 
prospect. Typical values include Requested More Info, Not Interested, 
Response Created Opportunity, and so on. By default, the value of 
this field is set to Unclassified Response.

Score An arbitrary value assigned by your organization. This field can be 
used to clarify whether a sales opportunity record should be created.

Source Code Unique number assigned to each campaign. Automatically 
populated.

Status Indicates whether campaign interactions with the current contact or 
prospect are complete or not. Available values are Open, Pending, 
and Closed.

Table 6. Some Fields in the Campaign Response Details Form

Field Comments

Downloaded File File the contact or prospect has downloaded from your 
organization’s Web site. Depending on your implementation, this 
field may be automatically populated.

Priority Indicates level of urgency for items to be mailed or shipped.

Ship Method Indicates how additional information should be communicated to 
the current contact or prospect. 
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Subject Brief description of the response.

Summary More detailed description of the response.

Time of Day For a call-back request, indicates the time of day to call back.

Table 6. Some Fields in the Campaign Response Details Form

Field Comments
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Promoting Campaign Prospects to Contacts
A prospect record can be promoted to a contact record as soon as the person 
represented by the record has expressed an interest in being in contact with your 
organization. For example, if you call a prospect whose name was obtained through 
renting a list of prospects, and if that person asks you to send further information 
about your products or services, your organization then has the right to treat that 
person as a contact, about whom information can be kept on file, instead of a 
prospect, who must be deleted from organizational records after a set time period.

If you create an opportunity as a result of a campaign call with a prospect, the 
prospect record is automatically promoted to a contact record, and that prospect is 
removed from the prospect list. For more information about the effects of promoting 
a prospect by creating a sales opportunity record, see “Promotion of Prospects to 
Contacts” on page 70.

If a prospect does not yet represent an opportunity, but has expressed interest in 
doing business with your organization, you can promote the Prospect record to a 
Contact record manually, as described in the following procedure.

To promote a campaign prospect to a contact

1 Navigate to the Overview view of the Campaigns screen, and select the 
appropriate campaign prospect record, as described in “To make an outbound 
campaign call” on page 151 or “To answer an inbound campaign call” on 
page 152.

2 Use the call guide or a SmartScript to verify that the current prospect qualifies 
to be promoted to a contact, but does not currently represent a sales opportunity. 

3 In the Overview list, click Promote.

Information disappears from the Prospect Last Name field and reappears in the 
Contact Last Name field. 

4 If you have not already done so, complete the call using the method described 
in one of the following procedures: 

■ “To record a brief campaign response” on page 157

■ “To create a detailed campaign response record” on page 160

5 Click the thread bar to return to the Campaign Overview view and proceed to 
your next call.
Version 7.5 Rev. A Siebel Call Center User Guide 163



Campaigns and SmartScripts

Promoting Campaign Responses to Opportunities
Promoting Campaign Responses to Opportunities
Occasionally, an agent may record a campaign interaction as a response, rather than 
a sales opportunity, but the interaction may lead to a sales opportunity at a later 
time. If this occurs, the campaign response record for the interaction can be 
promoted to an opportunity record, as described in the following procedure.

To promote a response to an opportunity

1 Navigate to the Responses screen.

2 From the Show drop-down list, select My Responses.

3 In the Responses list, select the response to promote.

4 Click the More Info view tab. 

5 In the More Info form, click Create Opportunity. 

NOTE: If the person being called is an existing contact, the application 
automatically associates the contact’s account with the opportunity. If the 
person being called is a prospect, the application automatically promotes the 
customer to a contact, and then associates the contact with an account.
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Different organizations have different requirements regarding how much 
information to store about campaign activities. Some organizations track campaign 
activities such as planning meetings, obtaining plan approvals, sending campaign-
related email, and so on.

An activity record can be associated with a campaign by entering the campaign 
name in the Source field for the Activity. Activity records that are created in the 
Campaign Activities view automatically have the Source field populated with the 
campaign name, even though the Source field is not visible in the Campaign 
Activities view. 

If you are using Siebel Call Center with the Communications tool bar, your software 
may be configured to create an activity record, automatically, for each incoming or 
outgoing phone call. Consult your Siebel administrator to find out whether the 
Source field is automatically populated for activity records created in this way. If the 
field is not populated automatically, you can enter the campaign data manually to 
associate the activity with the campaign. When an activity record contains a 
campaign name in its Source field, that record becomes visible in the Campaign 
Activities view for that campaign, even if the record was created in a different screen 
and view.

The following procedure describes one way to associate an activity record with a 
campaign, including optional steps for associating the activity with a particular 
campaign contact or prospect. 

NOTE: A single activity record can be associated with multiple contacts and 
prospects.

To associate an activity record with a campaign

1 Navigate to the Activities screen.

2 In the Activities list, select the activity you want to associate with a campaign.

3 In the More Info form, click the show more button.

4 In the Source field of the More Info form, click the select button to display the 
Lead Sources dialog box.
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5 In the Lead Sources dialog box, select the campaign you want to associate with 
the activity, and then click OK.

The selected campaign appears in the Source field.

6 If you want to associate this activity with a particular campaign contact, 
complete the following substeps:

a In the Contacts field of the More Info form, click the select button to display 
the Contacts dialog box.

b Click New to display the Add Contacts dialog box.

c Select the contact you want to associate with the activity, and then click OK 
to return to the Contacts dialog box.

d Click OK to return to the main window.

7 If you want to associate this activity with a particular campaign prospect, 
complete the following substeps:

a Click the Prospects view tab.

b In the Prospects list, click New to display the Prospects dialog box.

c Select the Prospect you want to associate with the activity, and then click OK. 
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Sending Correspondence to a Campaign Contact
One possible outcome of a campaign call is that a contact or prospect may request 
more information. The following procedure briefly describes how to send 
correspondence to a campaign contact. Siebel Call Center requires that a prospect 
be promoted to a contact before correspondence can be sent.

For more detailed information about creating and sending correspondence, see 
Siebel Sales User Guide. For information about setting up correspondence templates, 
see Applications Administration Guide. 

To send correspondence to a campaign contact

1 If you have not already done so, navigate to the Campaign Overview view, and 
select the contact to receive correspondence.

2 In the application-level menu, choose File > New > Correspondence.

A Correspondence list, a Recipients list, and an enclosures list appear. The 
Correspondence list contains a new record, already selected. The Recipients list 
contains a record for the contact you selected in Step 1. If you wish, you can 
click the Add button to add additional recipients.

3 Complete the fields in the Correspondence list.

4 In the Enclosures list, add literature items to be included with the 
correspondence.

5 When you have finished specifying the correspondence, choose one of the 
following methods to send it:

■ To print and mail the correspondence yourself, select the correspondence 
item in the Correspondence list, and then click the menu button and choose 
Print. After you mail the printed correspondence, select the correspondence 
item in the Correspondence list, and then click the menu button and choose 
Done to indicate that fulfillment is complete.

■ To submit the correspondence to the fulfillment center that is specified in the 
Correspondence record, click Submit.
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During or after a campaign, Siebel Call Center provides ways for you to evaluate 
campaign progress and effectiveness. You can inspect individual responses or view 
campaign statistics in the form of graphical charts. The following sections describe 
how to use these features.

Viewing Campaign Responses
Call center managers and campaign managers can view all responses to a particular 
campaign from the Campaigns screen, Responses view. The following procedure 
describes how to do this.

To view responses associated with a campaign

1 Navigate to the Campaigns screen.

2 From the Show drop-down list, select My Campaigns.

3 In the Campaigns list, select the campaign to which you want to view the 
responses.

4 Click the Responses view tab.

5 In the Response list, click the Description hyperlink of the response you would 
like to view additional details about.

Displaying Campaign Charts
Campaign charts allow campaign managers to assess performance and graphically 
display results in areas, such as incentive compensation, completed calls, and lead 
quality by campaign. 

The following procedure describes how to display a campaign chart. All the charts 
that can be displayed using this procedure are charts that show information for 
multiple campaigns, rather than a single, selected campaign.

To display a campaign chart

1 Navigate to the Campaign screen.

2 In the Campaigns list, select any campaign.
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3 Click the Charts view tab. 

You may need to click the tab jump button to scroll the view tabs to the right, in 
order to make the Charts view tab visible.

4 In the Show drop-down list in the Charts form, select the type of chart you want 
to display.

Available chart types are listed in Table 7, following this procedure.

Depending on the type of chart you have chosen, one or more additional drop-
down lists may appear below the Show drop-down list.

5 If you wish, choose new values in drop-down lists to adjust the chart style, the 
specific data to represent, or other chart characteristics, and then click Go. 

Table 7. Campaign Charts

Chart Description

Campaign Achievements Displays the results of the Sales Quota Plan set up for 
each campaign. It represents the percentage achievement 
of quota for each campaign.

Campaign Call Status 
Analysis 

Displays the number of calls that have been completed 
versus the number of calls that have not been completed 
for each campaign. Call center managers can use this 
chart to determine which campaigns are taking longer 
and how to shift resources.

Campaign Call Status 
Analysis by Employee

Displays the number of calls that have been completed 
versus the number of calls that have not been completed 
for each campaign for a specific employee. This chart is 
intended for use by managers.

Lead Quality Analysis by 
Campaign

Displays the opportunities that have been created for 
opportunity campaigns. It can display the opportunities 
based on each campaign or the opportunities based on 
their lead quality.

My Campaign Call Status 
Analysis

Displays complete versus incomplete calls for all contacts 
and prospects assigned to a particular agent for a specific 
campaign. This chart is intended for the agent’s use.
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Displaying Campaign Response Charts
Response charts allow campaign managers to assess performance and graphically 
display results in areas such as responses received from campaign calls, number of 
opportunities created, and number of responses per offer. 

The following procedure describes the how to display a response chart.

To display a response chart

1 Navigate to the Responses screen.

2 Click the Charts view tab.

Opportunity Revenue 
Analysis

Displays the total number of opportunities and the 
expected opportunity revenue for each campaign. Bars 
represent opportunity revenue and red dots represent the 
number of opportunities. 

Opportunity Revenue 
Analysis by Employee

Displays the total number of opportunities and the 
expected opportunity revenue for each employee. Bars 
represent opportunity revenue and red dots represent the 
number of opportunities. 

Order Revenue Analysis Shows the total number of orders created for each 
campaign and the total revenue generated for those 
orders.

Trend Analysis Displays the total number of responses for each 
campaign over a period of time. The period can be 
specified by day, week, month, quarter, and year.

Trend Analysis by 
Employee

Displays the total number of responses generated by each 
employee across campaigns over a period of time. The 
period can be specified by day, week, month, quarter, 
and year.

Table 7. Campaign Charts

Chart Description
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3 In the Charts form, in the Show drop-down list, select the type of chart you want 
to display. 

Available chart types are listed in Table 8, following this procedure.

Depending on the type of chart you have chosen, one or more additional drop-
down lists may appear below the Show drop-down list.

4 If you wish, choose new values in drop-down lists to adjust the chart style or 
other chart characteristics, and then click Go. 

Table 8. Response Charts

Chart Description

Response Campaign 
Analysis

Displays the total number of responses for each 
campaign. The campaign name is associated with the 
response. It is based on the campaign name in the All 
Responses list or the My Responses list.

Response Opportunity 
Analysis

Displays the total number of opportunities created for 
each campaign. This chart is based on the information in 
the Opportunity Source field.

Response Offer Analysis Displays the total number of responses per offer. This 
chart is based on the Offer name in the All Responses list 
or the My Responses list.

Response Offer Type 
Analysis

Displays the total number of responses per offer type. 
This chart is based how many responses were received 
for each offer type across all campaigns.

Response Offer Type 
Analysis by Campaign

Displays the total number of responses per offer type for 
each campaign. This chart is based on how many 
responses were received for each offer type within each 
campaign.
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Response Revenue 
Analysis

Displays the total revenue for each campaign and the total 
number of opportunities for each campaign. The bar 
chart has the revenue by campaign and the line graph 
shows the number of opportunities for each campaign. 
The revenue number comes from the sum of the Revenue 
field in the opportunity with the Source field equal to the 
campaign name.

Response Average 
Opportunity Revenue 
Analysis

Displays the average revenue for each campaign. For each 
opportunity created for the campaign, the revenue is 
added and the average is taken across all opportunities 
created for the campaign.

Table 8. Response Charts

Chart Description
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